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Preface
ADOUL ThiS GUIAE ..o 9
Support and SeTVICE ... 9
Archer DoCUMENtAtION . 10

About This Guide

This guide provides Archer® Suite administrators with instructions for installing and upgrading
Archer. This guide assumes the reader has knowledge of Microsoft Internet Information Services
(I1IS)®, Microsoft SQL Server®, Windows Servers®, ScaleOut StateServer®, Redis ™, and also has
the appropriate permissions to the infrastructure.

Support and Service

Open a Support case via the toll free phone number for your locale, or using the Case Management
portal on Archer Community. Step by step instructions for opening a Support case and using the
Case Management portal can be found here: https://community.rsa.com/t5/support-information/how-
to-contact-rsa-support/ta-p/563897.

Other Resources
Resource Description

Archer Community Our public forum, on the Archer
Community , brings together customers,
partners and analysts to discuss risk and
compliance as a practice.

https://community.rsa.com/t5/archer/ct-

p/archer
Archer Customer / Partner Our private community is a powerful
Community governance, risk and compliance online

network that promotes collaboration
among customers, partners, industry
analysts, and product experts.
https://community.rsa.com/t5/archer/ct-
p/archer
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Resource

Archer Exchange

Description

The Archer Exchange offerings help you
rapidly deploy adjacent or supporting risk
business processes, quickly integrate new
risk data sources, and implement
administrative utilities to make the most
out of their risk and compliance
investment.

https://community.rsa.com/t5/archer-
exchange/ct-p/archer-exchange

Archer Documentation

You can access Archer documentation on the Archer Community:
https://community.rsa.com/t5/archer-platform-documentation/tkb-p/archer-platform-documentation.

The following table describes each document.

Document

Platform
Planning Guide

Platform
Installation and
Upgrade Guide

Online
Documentation

Archer Control
Panel (ACP) Help

Security
Configuration
Guide

Preface

Description

Information about how to plan for your Archer installation. This document
is intended for system administrators who are responsible for installing and
managing Archer.

Instructions for installing and upgrading to the latest Archer release. This
document is intended for system administrators who are responsible for
installing and managing Archer.

Information for using Archer, including how to set up, maintain, and use the
Archer Platform, security configuration information, and information on the

solution use cases. Available from within Archer.

Information for using the Archer Control Panel (ACP) module to manage
the internal settings of the Platform, such as license keys, global paths and
settings. Available from within the ACP module.

Information about security configuration settings available in the Archer
Platform and security best practices for using those settings to help ensure
secure operation of Archer.

10
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Chapter 1: Components and System Requirements

This chapter introduces the main components of Archer installation, the types of available
configurations, and the requirements for running your environment.

Archer Components

There are several main components to an Archer installation.

e Web Application

e Instance Database

e File Repository

e Configuration Database

e Services

For the supported and qualified software and environments, see Archer Qualified and Supported

Environments on the Archer Community. (https://community.rsa.com/t5/archer-platform-
documentation/rsa-archer-qualified-and-supported-environments/ta-p/568750)

Web Application

The Archer Platform uses a web-based user interface that runs on a Web Server. Manage the Web
Application through an Application Pool using Microsoft® Internet Information Services (IIS).

Microsoft Internet Information Service (IIS). For additional information, see System Requirements.
The application is managed through an Application Pool through the Internet Information Services
(IIS). For additional information, see Application Pool Requirements.

Instance Database

An Archer instance is a single setup that includes unique content in a database, the connection to the
database, the interface, and user credentials. For example, you may have individual instances for
each office location or region, or for development, test, and production environments.

File Repository

The File Repository stores components for the configuration. For example, the File Repository
provides storage for the following services:

Chapter 1: Components and System Requirements 11
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e Attachments uploaded as content
e Temporary files, such as packages, exports
e Data feeds

e Charts created by reports and searches

Configuration Database

Thee Configuration Database stores data that is not instance specific. For example, client information
and application information (including date and version).

Services

There are several services, listed with Microsoft Windows Services, that control various functions of
Archer. They control features such as configuration data, job engine, and advanced workflow.

The following table describes the Archer services.

Service Description
RSA Archer Connects to the Configuration Database, where configuration
Configuration parameters of the Platform and Archer services are stored.

Note: This service must be installed and enabled on all web and
Services Servers.

RSA Archer Supports user and group maintenance by synchronizing the users
LDAP Synchronization and groups in Archer to users and groups in another system
through Lightweight Directory Access Protocol (LDAP).

Note: This service only needs to be active if you are using LDAP
to manage user accounts.

RSA Archer Job Engine Administers all asynchronous job processing for Archer data feeds,
findings generation, notifications, recalculations, and system jobs.
For a complete listing of processing and system jobs, see "Job
Types" in the Archer Control Panel Help.

I Note: This service is required to be installed for Archer to run.

Chapter 1: Components and System Requirements 12
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Service

RSA Archer Queuing

RSA Archer Advanced
Workflow

RSA Archer Core

Archer Operational Risk

Description

Builds and maintains indexes for keyword search and file
attachments. You can only have one RSA Archer Queuing service
enabled for an Archer instance.

Note: This service is required on the Services Server assigned to
queuing.

Administers the Advanced Workflow feature for processing
workflows. This service is an integral part of Archer and should be
running all the time. For solutions use cases in which the
Advanced Workflow feature is available, workflow does not
function unless the RSA Archer Advanced Workflow service is
running.

Note: As of version 6.1, the Advanced Workflow service can be
installed on a Web Server or Services Server specified during
installation. A example configuration dedicates Advanced
Workflow service to two Web Servers behind a load balancer.

Interacts with the Advanced Workflow service to provide
Advanced Workflow functionality. The Core service is an integral
part of Archer and should be running at all times. For solutions use
cases in which the Advanced Workflow feature is available,
workflow does not function unless the Core service is running.

Note: The Archer installer automatically installs this service on
each Web Server or Services Server where you install the
Advanced Workflow service. An example configuration dedicates
the Advanced Workflow service to two Web Servers behind a
load balancer.

Interacts with the Advanced Workflow service to provide custom
functionality for several applications in the Operational Risk
Management solution. This service must be running in order to use
the Operational Risk Management solution.

Note: The Archer installer automatically installs Operational Risk
service on each server where you install the Advanced Workflow
service.

Chapter 1: Components and System Requirements 13
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Archer Configurations

Archer can be structured in various configurations, depending upon your unique needs.

It is recommended that you choose a configuration that is easily adaptable and scalable to the
growing demands of your business. When determining which configuration is best for you, consider
the expected user load, utilization, and availability requirements for your business operations. For
additional information about optimizing performance, see the Archer Platform Planning Guide.

Recommended Configuration

For optimal scalability and performance, it is recommended that you use a multiple server
configuration for Archer. This configuration includes dedicated servers for hosting the Web
Application and the services. Each server plays a specific role within the Archer configuration.

Database Description

Instance The primary database for storing Archer
content. The Content Database is synonymous
with Instance Database.

Configuration A central repository for configuration
information for the Web Application and
Services Servers. This database facilitates the
installation and maintenance of multiple
application servers in a multiple server
deployment.

Test Environment Configuration

The test environment configuration consists of a single server that hosts the Web Application and
services. This configuration is recommended for test environments only. Other resources can be
installed on additional servers. For instructions on how to set up this environment, see the Appendix
B: Test Environment.

Chapter 1: Components and System Requirements 14
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Archer Configuration Considerations

A recommended Archer configuration meets the needs of current processing with room for future
growth. It provides greater flexibility and is highly scalable because each layer can be scaled
independently. The Web Application, services, and content reside in different databases on separate
servers. This type of configuration also supports high-availability environments that use load
balancing to distribute loads based on server availability. Incoming HTTP requests are directed
across the Web Servers using a load balancer, which distributes loads based on server availability
according to the selected criteria.

For enhanced security, incorporate a double firewall. This configuration places a firewall in front of
the Web Server with another residing between the web and database servers.

For enhanced reliability, incorporate caching into your configuration by having multiple servers
running simultaneously. To enable third-party caching, follow the recommendations from the
caching provider. Caching is often installed one more than one server to ensure that if the main
server goes down, the traffic shifts to the another running server. These servers run the Cache
Services only.

Recommended Configuration

Each server plays a role and runs IRM components specific to that role. The following table shows
the recommended configuration.

Services Server = Web Server File Server Database Server
RSA Archer Web Application File Repository Instance Databases
Configuration
Service
RSA Archer Job RSA Archer Configuration
Engine Service Configuration Service Database
Other Services RSA Archer Workflow

Service

Recommended Configuration with Caching

You can configure Archer to meet specific needs, like caching. In this case, your configuration might
look similar to the following table:
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Archer Platform Installation and Upgrade Guide

Cache Servers Services
Server
RSA Archer Job

Engine Service

Third-party
caching
application

(Optional)
ScaleOut
StateServer
Client

(Optional)
Redis

Note: Client
installation is
not necessary.

Other Services

System Requirements

Web Server

RSA Archer
Configuration
Service

(Optional)
ScaleOut
StateServer
Client

(Optional)
Redis

Note: Client
installation is
not necessary.

RSA Archer
Workflow
Service

File Server

Database
Server

Configuration
Database

The recommended system requirements vary based on the number of concurrent users and the
amount of data stored in Archer. Use a server configuration that supports moderate transaction

levels. For a complete list of system performance requirements and characteristics, see the Archer

Platform Planning Guide.

Recommended Configuration Requirements

Use the latest qualified versions of specific software for running Archer in the recommended
configuration. For the supported and qualified software and environments, see Archer Qualified and
Supported Environments on the Archer Community. (https://community.rsa.com/t5/archer-platform-

documentation/rsa-archer-qualified-and-supported-environments/ta-p/568750)

License Keys

License keys are required for certain situations.

Chapter 1: Components and System Requirements
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Process License details
Install a new instance Contact your Archer account representative.
Upgrade from 6.3 or later No action needed.

Important: When upgrading, do not apply the new license key until after you upgrade the Archer
Platform. If you apply the license first before upgrading, you may lose access to legacy core
applications that are no longer supported in the out-of-the-box use cases.

License Agreement - Instance Creation

With the purchase of each Archer license, you receive permission to create a single environment for
one production instance and two non-production instances.

Cloud and Hosting Support

Archer supports hosting in Microsoft Azure® and Amazon Web Services® (AWS) cloud
environments. This section provides information to assess and plan for an installation using cloud
environments.

When using cloud vendors, only using virtual machines to run your Archer environment is
supported.

Use the same process for a cloud or hosted environment as outlined in the Archer Platform Planning
Guide to determine your environment size. Choose a product from your cloud provider that most
closely matches your configuration requirements.

For example, consider the specifications for a small environment given in Archer Platform Planning
Guide. As of this publication, the details in this table are accurate based on current vendor
specifications.

Azure (Standard_
Element Small Environment = AWS (m4.xlarge)
DS3 package)

Processor Four cores Four cores Four cores
Memory 16 GB 16 GB 14 GB
Disk Space 50 GB HDD 100 GB SSD (Using 100 GB HDD

Elastic Block Store)

Note: This table describes hardware requirements only. To understand all requirements for your
configuration, see "Sizing Guidelines" in the Archer Platform Planning Guide.

Chapter 1: Components and System Requirements 17
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Other factors to consider when preparing your cloud-based configuration:

e Input/Output per second (IOPS) directly affects your Archer performance. If you find your
performance is slow, consider choosing a vendor product with more IOPS per disk.

e Communication between your on-premises systems and your cloud vendor is key. Contact your

vendor to select a method that works best for your environment.

For more information about the different vendor products offered, review the Azure and
AWS documentation:

e For Azure, see https://docs.microsoft.com/en-us/azure/.

e For AWS, see https://aws.amazon.com/.

Chapter 1: Components and System Requirements 18
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Chapter 2: Installing Archer

This chapter guides you through performing a new installation.

Installation
Your Archer infrastructure configuration must meet the minimum requirements outlined in System
Requirements. For more details on how to prepare, see Preparing the Servers.

These instructions follow the recommended installation, in which you will install the Web
Application and Services components on all Web Servers and the Services component on all
Services Servers.

Preparing Archer for Installation

Plan and prepare your system for installing Archer. This requires the expertise of IT and database
administrators. A worksheet is provided to keep track of administrator credentials. See the Pre-
Installation Worksheet in Appendix C.

Responsible Role Administration Task

IT administrators Install and configure these software packages:

e Microsoft Windows Server

e Microsoft Internet Information Services
(11S)

e Microsoft NET Framework
e Microsoft SQL Server
e ScaleOut StateServer (Client and Server)

e Redis (See the Redis documentation for
supported Linux versions.)

For the supported and qualified software and
environments, see Archer Qualified and
Supported Environments on the Archer
Community.
(https://community.rsa.com/t5/archer-platform-
documentation/rsa-archer-qualified-and-
supported-environments/ta-p/568750)

Chapter 2: Installing Archer 19


https://community.rsa.com/t5/archer-platform-documentation/rsa-archer-qualified-and-supported-environments/ta-p/568750
https://community.rsa.com/t5/archer-platform-documentation/rsa-archer-qualified-and-supported-environments/ta-p/568750

Archer Platform Installation and Upgrade Guide

Responsible Role Administration Task
IT administrators Configure network shares.
IT administrators Run the IIS Application Pool and services as a

domain-based services account to access the
Network Share.

Database administrators Manage the following:
e Databases with database owner roles.

¢ Authentication methods for database
connectivity.

Preparing the Servers

1. Prepare the Database Servers.

2. Prepare the Web Servers.

3. Prepare the Services Servers.

4. (Optional) Prepare the Cache Servers by following the guidelines from the caching provider.

See Appendix D: Preparation Checklist for worksheets and checklists that you can use to plan and
track your work.

Preparing the Database Servers

The Database Server stores database information, such as the Instance Database and the File
Repository, for Archer. A configuration can have multiple Database Servers depending upon the
environment complexity.

Prepare each database by following these tasks:
1. Verify that the database requirements are met.
2. Choose the Authentication method.

3. Repeat steps 1-2 on all databases in your Archer configuration.
Prepare the following SQL databases before installing Archer.

¢ Instance Database

* Configuration Database

Chapter 2: Installing Archer 20
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Task 1: Verify database requirements are met

Verify that the databases meet the requirements in the following table.

Field Required Value

Collation Settings Case insensitive

SQL Compeatibility level 140

User Account Database Owner role

Locale English (United States)
TCP/IP Enabled SQL Server instance

Task 2: Determine the authentication method to use

Authentication methods authorize users to perform computer functions and determine the
connectivity to the databases. The method you use is entirely up to your business operations. The
following table describes two methods of connecting to the three databases in Archer.

Database Description

SQL Server Authentication Archer connects to each database using a SQL
account created on the SQL Server instance.
You provide the account information during
the installation process.
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Database Description

Integrated Security Archer connects through a Windows identity
established on the operating system thread
using an Active Directory domain user
account. You must configure the Application
Pool Identity in IIS as the domain user account
before installing Archer. This domain user
account has DB Owner (DBO) access to the
instance database that serves as the process
identity for applications assigned to the
application pool.

It is recommended to create a custom domain
services account dedicated to Archer for the
IIS Application Pool Identity, and then
providing it access to the necessary resources.
In addition, be prepared to provide the same
account credentials for the Archer Services
account during the installation process.

Note: The term Integrated Security is
synonymous with Trusted Connections. Use
the Application Pool to isolate the Web
Application when there are multiple IIS
worker processes that share the same Web
Server.

Preparing the Web Servers

The Web Server hosts the Web Application and RSA Archer Configuration service. A configuration
can have multiple Web Servers depending upon the environment complexity.

Prepare the Web Servers by completing the following tasks:
1. Verify that the Web Server requirements are met.

2. Configure IIS.

3. Verify the application pool requirements.

4

. Confirm the user account.

The Web Server hosts the Web Application and configuration service of Archer. Use the Archer
Platform Planning Guide to determine the best configuration for your data.
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Task 1: Verify the Web Server requirements are met

The following chart identifies each component on the Web Servers and its requirements. Set up your
Web Servers accordingly. For the supported and qualified software and environments, see Archer
Qualified and Supported Environments on the Archer Community.
(https://community.rsa.com/t5/archer-platform-documentation/rsa-archer-qualified-and-supported-
environments/ta-p/568750)

Component Requirement

Operating System Administrator rights during the installation
process.

Microsoft Internet Services IIS IIS must be installed prior to installing .NET.

If not, the appropriate .NET mappings may not
be applied. Failure to follow the proper
installation sequence as presented in this guide
may result in having to re-register the
Microsoft. NET Framework.

Microsoft .NET If you are performing a new Archer installation
on multiple Web Servers, you must configure
the domain service account with full access to
Archer and .NET Temporary Files directories.

(Optional) Microsoft Filter Pack If you want keyword searches to include
Microsoft Office documents, install this on
your Web Servers.

Microsoft C++ 2010 Redistributable x64
installation is required in order to search PDF
files.

(Optional) ScaleOut StateServer Client If you want to enable caching with ScaleOut
StateServer, install the client on Web Server.

Task 2: Configure IIS

It is assumed that the IT Administrator is familiar with the process of configuring your IIS. The
IT Administrator should complete the following tasks after installing the web server. Use the
Microsoft Server Manager Dashboard to configure the IIS accordingly. For the supported and
qualified software and environments, see Archer Qualified and Supported Environments on the
Archer Community. (https://community.rsa.com/t5/archer-platform-documentation/rsa-archer-
qualified-and-supported-environments/ta-p/568750)
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1. Install Microsoft NET Framework.

Required Options Value

Microsoft .NET Framework Features NET Framework version
ASP.NET version

WCF Services HTTP Activation

TCP Port Sharing

2. Install the required IIS roles and features. Disable the WebDAYV Feature (Archer does not
support this feature).

Required Option Value

Common HTTP Features Default Document
Directory Browsing
HTTP Errors

Static Content

Health and Diagnostics HTTP Logging
Application Development NET Extensibility
ASP NET

ISAPI Extensions

ISAPI Filters
Security Request Filtering
Performance Static Content Compression

Dynamic Content Compression

Note: HTTP compression is enabled by
default. If using a load balancer, disable
HTTP compression from the Web Servers
and configuring HTTP compression to
occur on the load balancer.

Management Tools IIS Management Console

Application Pool > Managed Pipeline Mode Integrated
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3. Input the required values for IIS.

Required Option Value
ISAPI and CGI Restrictions Allow ASP.NET
Authentication Method Anonymous

Important: Only enable one authentication method; more than one authentication method
causes errors in the Manage Users, Manage Groups, and Report features of Archer.

Create the application pool (for information on how to create an application pool, go to
technet.microsoft.com). Ensure that the Managed pipeline mode is set to Integrated. Not all
product features are supported in Classic mode.

4. Verify that the Server runs.

Task 3: Verify the application pool requirements

An application pool is required for administrating the Archer Web Application. The application pool
defines the set of Web Applications that share one or more worker processes, which are Windows
processes that run Web Applications. For the supported and qualified software and environments, see
Archer Qualified and Supported Environments on the Archer Community.
(https://community.rsa.com/t5/archer-platform-documentation/rsa-archer-qualified-and-supported-
environments/ta-p/568750)

Required values for configuring the application pool

Required Option Value

Application Pool Name Choose a name that makes sense to you.
NET Framework version supported version

Start application pool immediately Select this checkbox.

Task 4: Confirm user account

Archer requires a specified user account for accessing the various files in the Web Server. Make sure
your credentials work appropriately.

Preparing the Services Servers

1. Verify the Services server requirements.

2. Configure the network share.
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3. (Optional) Configure the keyword indexing for attachments.

Task 1: Verify the Services Server requirements

Review and verify the component requirements. For the supported and qualified software and
environments, see Archer Qualified and Supported Environments on the Archer Community.
(https://community.rsa.com/t5/archer-platform-documentation/rsa-archer-qualified-and-supported-
environments/ta-p/568750)

e Microsoft NET

e Microsoft Windows Server (You must have administrator rights during the installation process.)

e Microsoft Filter Pack (Optional) (Install the components on each web server to enable the
Microsoft Office document keyword search.)

e Scaleout StateServer Client (Optional) (Install the client on your web server to enable caching
with ScaleOut StateServer)

Task 2: Configure the network share

Configure your Network Share to:
e Maintain the File Repository and Company _files to be accessible to all servers.

e Allow read and write permissions to the pre-defined domain-based service account.

Note: Running the IIS Application Pool and the services as a domain-based services account
enables Archer to access the Network Share regardless of where they reside in the network.

e Place search indexes and Archer Queuing services on the same server.
e Reside on one of the following:

° One of the designated Archer servers.

© Standardized file server/NAS.

The following table describes the authentication details depending on the number of servers in the
Archer environment.

SQL Database Servers Windows Integrated

DB Authentication
Number of Servers 2 or more 2 or more
Database authentication SQL credentials Windows Integrated Security

method
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Windows Integrated

SQL Database Servers DB Authentication

Archer Services log on Domain account Domain account
account
IIS Application Pool Domain account Domain account

Task 3: Configure the keyword indexing for attachments (Optional)

Archer can perform keyword searches of Microsoft Office documents attachments. This
configuration is optional, but necessary if you are using the supported version of the Microsoft Filter
Pack or SMTP service.

If you are using localhost as the notifications mail relay server, install the SMTP Service in IIS and
configure the Relay Restrictions with the loopback IP address.

Preparing the Primary and High Availability Servers (Optional)

1. Verify the Cache Server software requirements from ScaleOut StateServer or Redis.

2. If you use Virtual Machines, contact your Virtual Infrastructure administrator to verify assigned
memory and guarantee 100% CPU resources. Performance degradation can occur if you do not
have sufficient resources

Installing Components

Once the servers are prepared, install Archer using the following methods for each of your servers.
 Installing the Web Application and Services Components

 Installing the Services Server

See Appendix D: Installation Checklist for worksheets and checklists that you can use during
installation.

Installing the Web Application and Services Components

Run this installation on your Web Server to install Archer Web Application and configuration
services.
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Task 1: Prepare the installer package

L.

Download the Archer installer package from Archer Community.
https://community.rsa.com/t5/archer/ct-p/archer

(Optional) Verify that you have downloaded the installer package correctly by comparing the
checksum values from your downloaded Archer files to the checksum values for your Archer
Platform version displayed on the download page.

. Use the Run as Administrator option to extract the installation package on the server to a location

that is accessible to other servers.

Back up the instance and configuration databases created during the server preparation process.
This process ensures that your data is current so that you can recover it if necessary.

Task 2: Run the installer on all Web servers and Services servers

Run the installer on all web and services servers.

1.

NS kL

Open the installation folder, and right-click Archerlnstall.exe.

Select Run as Administrator.

Click OK.

Select the appropriate language for the installer to use.

Read the license agreement, and select I accept the terms in the license agreement.
Read the Diagnostics and System Data License.

Click Next.

Task 3: Install the Web Application and services

Begin at the Archer - Installation Options page.

1.

2.

Verify that the following components are selected:
e Web Application

e Services
Note: Disable unwanted services after installation.

¢ Instance Database
e Advanced Workflow Service

Click Next.
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Task 4: Specify the X.509 certificate

Important: You must use the same X.509 certificate during installations on all types of servers.
For more information, see X.509 Certificates.

Begin at the Archer - Specify Certificate page.

1.

In Specify where to obtain the X.509 certificate, do one of the following:
» Select Create a certificate to create a new certificate.
e Select an existing certificate from a disk or a certificate store.
o If selecting from a disk, do the following:
a. Choose Select from disk.
b. In Specify the file to import into the certificate store, click E and select the certificate
file.
c. Click OK.
d. In Type the password for the private key, enter the applicable certificate password.
° If selecting from a certificate store, do the following:
a. Choose Select from certificate store.
b. In Select a certificate from the store, expand the category and select the certificate.

Click Next.

Task 5: Set the configuration database options (if prompted)

Complete this task only if prompted during the installation process. If the installer detects the Archer
Configuration service, the Archer - Configuration Database Options page does not display.

Begin at the Archer - Configuration Databases Options page.

1.
2.

In SQL Server, enter the SQL Server that hosts the Configuration Database.
If you are using a SQL Server account, enter the following, otherwise, go to step 4.
e Login name

¢ Password

. If you are using integrated security, do the following, otherwise, go to step 4.

a. Select User integrated security.

b. In Database, enter the Instance Database.
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4. In Database, enter the Configuration Database.

5. Click Next.

Task 6: Configure Advanced Workflow HTTPS

Begin at the Archer - Specify HTTPS Binding Certificate page.

I Note: Advanced workflow requires a dedicated certificate.

1. Enter the port to securely communicate with the Advanced Workflow Service in HTTPS Port.

2. Do one of the following:

Note: The port numbers for Advanced Workflow REST URL and Advanced Workflow
Communication Port cannot be the same when using HTTPS. For example, by default, the
Advanced Workflow REST URL default port is 8443 and the Advanced Workflow
Communication default port is 8000.

e Use HTTPS
© Specify where to obtain the X.509. Do the following:

B [f using current certificate, select Use current certificate.

I Note: This option is unavailable, if this is the first installation for your configuration.

B [f selecting from a certificate store, do the following:
a. Select from certificate store.

b. In Select a certificate from the store, expand the category and select the certificate.

© Specity the HTTPS Port.
Note: If the system detects the specified port number is in use, you must confirm you
wish to replace the certificate bound to the specified port.

e Use HTTP only (Not recommended).
3. Click Next.

Task 7: Set the REST URL and Communication Port for Advanced Workflow service

Begin at the ArcherAdvanced Workflow Settings page.
1. Ifusing HTTP, click Next.
2. During HTTP, Archer uses default ports and URLs.
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3. Ifusing HTTPS, do the following:

a. Change Advanced Workflow REST URL to the same value specified when configuring
Advanced Workflow HTTPS. For example, https://hostName:8000/ where hostName is the
fully qualified domain name of the host where the Advanced Workflow Service is installed.
If there are multiple Advanced Workflow Service hosts, hostName is the FQDN name for the
load balancer and the port number refers to the port for which you have configured the load
balancer.

b. Change the Advanced Workflow Communication Port to a different port than you specified
when configuring Advanced Workflow HTTPS. (The default value is 8000).

Note: If this is a new install, the system populates this field with information from the
certificate and HTTPS port used to configure Advanced Workflow HTTPS.

c. Click Next.

Task 8: Select the language for Archer and content (if prompted)

If you did not check the Instance Database box in Task 6, this task is skipped automatically.

Begin at the Archer Language page.

1.

In Select the language for Archer, select the language that you want to use for Archer. By
default, the language is US English. The supported languages are English (US), Chinese
(Simplified), French, German, Italian, Japanese, Portuguese (Brazil), and Spanish (Latin
American).

Click Next.

Task 9: Set the instance database

Begin at the Archer - Instance Database Options page.

1.

In SQL Server, enter the server name.
If the SQL Server is configured for a custom port, enter [servername],[portID].

If you are using a SQL Server account, enter the following, otherwise go to step 4.
e Login name

e Password

If you are using integrated security, do the following, otherwise go to step 4.

a. Select User integrated security.

b. In Database, enter the instance database.

Click Next.
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Task 10: Set the default time zone for the configuration database (if prompted)

This time zone for the configuration database applies to all instances unless you override it for a
specific instance in the Archer Control Panel.

Note: If the installer detects a timezone, the web application options page opens and you can
move on to task 11.

Begin at the Archer - Time Zone page.
1. In Time Zone, select the default time zone for Archer.

2. Click Next.

Task 11: Configure the Web Application options
Begin at the Archer - Web Application Options page.
1. In Website, select the destination site for the Archer Web Application.

2. Under Destination directory, verify that destination directory is set to the Web Application
installation:

e Install in the website's default application.
 Install in an IIS application.
3. Click Next.

4. Click Yes to confirm the destination directory.

Task 12: Enable HTTPS automatically for communication between Web Servers and web traffic
If prompted, begin at the Archer - Specify HTTPS Binding Certificate page.
1. Do one of the following:
e Use an Existing Binding.
e Create a New Binding.
© Specify where to obtain the X.509.
B [f selecting from a disk, do the following:

a. Select from disk.

b. In Specify the file to import into the certificate store, clicklZI and select the file.
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c. Click Open.

d. In Type the password for the private key, enter the applicable certificate password.
B [fselecting from a certificate store, do the following:

a. Select from certificate store.

b. In Select a certificate from the store, expand the category and select the certificate.

2. Click Next.

Important: It is recommended to remove any existing HTTP binding from IIS to ensure secure
configuration.

Task 13: Configure the service credentials

Begin at theArcher - Services Credentials page.
1. Select
e Use the Local System account to run all services.
e Use the specified account to run all services and provide Account Credentials.

2. Click Next.

Note: To allow correct Archer Services installation, ensure that Log on as a Service is enabled for
the Window Services Account.

Task 14: Set the services and application file paths

Begin at the Archer - Services and Application Files page.

1. In Services, enter the path where the services are installed.
By default, the path is C:\Program Files\RSA Archer\Services.

2. In Application Files, enter the path where the application files are installed.
By default, the path is C:\Program Files\RSA Archer.

Note: It is recommended that you do not install Web Application or products in the same
virtual directory or Root of Archer. Browsers send Cookies if more than one Web Application
resides in same space; this behavior may lead to passing Archer cookies to any other
application installed in same Root or Virtual Directory.
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3. In Program Group, do one of the following, and click Next.
e Create RSA Archer program group for the current user only.
e Create RSA Archer group for all users (Recommended).
e Do not create RSA Archer program group.

4. Click Next.

5. Click Yes to confirm the newly created directories and program group.

Task 15: Set the path for the installer log file

Begin at the Archer - Log Location page.

1. In Log Path, enter the folder in which you want to store the log files. All servers in the Archer
environment use this path for logging events. When setting this path, use the same path for all
web and services servers.

2. Click Next.

Task 16: Perform the installation

Begin at the Archer - Perform Install page.

1. Click Next.
The installer starts installing the applicable components. A progress bar opens.

2. Wait for the installer to complete installing the applicable components.

3. Click Finish.
The ArcherControl Panel opens.

Task 17: Set the instance database options

In the Archer Control Panel, begin at the Archer - Instance Database Options page.

1. In SQL Server, enter the server name. If the SQL Server is configured for a custom port, enter
[servername],[portID].
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2. Do one of the following for connecting to the instance database:

Database Management System Do the following
SQL Server Enter Authorization credentials

Integrated Security In Database, select Use integrated security

3. Click Next.

Task 18: Stop all Archer services except Archer Configuration and Archer Workflow services

Ensure all Archer services are stopped, but the RSA Archer Configuration service continues to run.

1. Run Windows Services as Administrator.
2. Scroll until the RSA Services appear.
a. Right click each Service in turn.
I Note: Do not select RSA Archer Configuration or RSA Archer Workflow services.
b. Select Stop.

Installing the Services Server

Run this installation on each services server.

Task 1: Prepare the installer package
1. Download the Archer installer package from Archer Community.
https://community.rsa.com/t5/archer/ct-p/archer

2. (Optional) Verify that you have downloaded the installer package correctly by comparing the
checksum values from your downloaded Archer files to the checksum values for your Archer
Platform version displayed on the download page.

3. Use the Run as Administrator option to extract the installation package on the server to a location
that is accessible to other servers.

4. Back up the instance and configuration databases created during the server preparation process.
This process ensures that your data is current so that you can recover it if necessary.

Task 2: Run the installer as administrator

Run the installer on all web and services servers.
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1. Open the installation folder, and right-click ArcherInstall.exe.

Select Run as Administrator.

Click OK.

Select the appropriate language for the installer to use.

Read the license agreement, and select [ accept the terms in the license agreement.
Read the Diagnostics and System Data License.

Click Next.

A

Task 3: Install the Services component

Begin at the Archer - Installation Options page.

1. Verify that only desired components are selected.

I Note: When upgrading, options used in past installations are automatically selected.

e Services Server

2. Click Next.

Task 4: Specify the X.509 certificate

Important: You must use the same X.509 certificate during installations on all types of servers.
For more information, see X.509 Certificates.

Begin at the Archer - Specify Certificate page.
1. In Specify where to obtain the X.509 certificate, do one of the following:
e Select Create a certificate to create a new certificate.
e Select an existing certificate from a disk or a certificate store.
° If selecting from a disk, do the following:
a. Choose Select from disk.
b. In Specify the file to import into the certificate store, click E and select the certificate
file.
c. Click OK.

d. In Type the password for the private key, enter the applicable certificate password.
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° If selecting from a certificate store, do the following:
a. Choose Select from certificate store.
b. In Select a certificate from the store, expand the category and select the certificate.

2. Click Next.

Task 5: Set the configuration database options

Complete this task only if prompted during the installation process. If the installer detects the Archer
Configuration service, the Archer - Configuration Database Options page does not display.

Begin at the Archer - Configuration Databases Options page.
1. In SQL Server, enter the SQL Server that hosts the Configuration Database.
2. Ifyou are using a SQL Server account, enter the following, otherwise, go to step 4.
e Login name
e Password
3. If you are using integrated security, do the following, otherwise, go to step 4.
a. Select User integrated security.
b. In Database, enter the Instance Database.
4. In Database, enter the Configuration Database.

5. Click Next.

Task 6: Configure the service credentials
Begin at theArcher - Services Credentials page.
1. Select
e Use the Local System account to run all services.
e Use the specified account to run all services and provide Account Credentials.

2. Click Next.

Note: To allow correct Archer Services installation, ensure that Log on as a Service is enabled for
the Window Services Account.
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Task 7: Set the services file and application file paths

Begin at the Archer - Services and Application Files page.

1.

In Services, enter the path where the services are installed.
By default, the path is C:\Program Files\RSA Archer\Services.

In Application Files, enter the path where the application files are installed.
By default, the path is C:\Program Files\RSA Archer.

Note: It is recommended that you do not install Web Application or products in the same
virtual directory or Root of Archer. Browsers send Cookies if more than one Web Application
resides in same space; this behavior may lead to passing Archer cookies to any other
application installed in same Root or Virtual Directory.

In Program Group, do one of the following, and click Next.

e Create RSA Archer program group for the current user only.
e Create RSA Archer group for all users (Recommended).

e Do not create RSA Archer program group.

Click Next.

Click Yes to confirm the newly created directories and program group.

Task 8: Set the path for the installer log file

Begin at the Archer - Log Location page.

1.

In Log Path, enter the folder in which you want to store the log files. All servers in the Archer
environment use this path for logging events. When setting this path, use the same path for all
web and services servers.

Click Next.

Task 9: Perform the installation

Begin at the Archer - Perform Install page.

1.

Click Next.

2. Click Finish.
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Chapter 3: Upgrading Archer

This chapter guides you through the process of upgrading your Archer in the recommended
configuration, including preparing for the upgrade and the tasks for upgrading the Archer
components.

Upgrade Recommendations

You must be running version 6.3 or later to upgrade to version 6.9 and later.
It is possible to upgrade Archer with or without patches.

If you are running Archer 6.2 or earlier, you must first upgrade to 6.8 and then upgrade to 6.9 and
later. For information about upgrading to Archer 6.8, see the Platform Installation & Upgrade Guide
on Archer Community.

Preparing Archer for Upgrading

To prepare for your upgrade, do the following:
e Schedule the upgrade during off-peak hours.

e Complete only the necessary steps to upgrade the components to the version you are installing.
The installer extracts the data from the earlier version of your configuration and uses this data for
upgrading the components during installation.

e Migrate all databases to a supported version of SQL Server.
e Stop all job engines and services, except for the Archer Configuration Service.

e Reuse the X.509 certificate that you used in your original installation of Archer.

Important: The Archer instance is not available during the upgrade.

When you upgrade to release 6.8 or later, users and groups selected in the Application Owner field
are now selected in both the Configuration Administrator and Content Administrator fields. New
configuration and content administration rights take effect immediately upon upgrade. Original
application owners should have the same access to configuration and content that they did prior to
the upgrade.

Upgrading All Components

It is recommended to upgrade all components at the same time to ensure that your instance database
is also upgraded. Use the Upgrade Installation Worksheet to complete this task.
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Important: You must run this upgrade on a Web Server or a server running IIS. Only run this
upgrade once for upgrading the instance database. Follow the instructions for upgrading the other
components at their respective web or Services Servers. See Upgrading the Web Servers and
Upgrading the Services Servers.

Task 1: Prepare the installer package

1.

Download the Archer installer package from Archer Community.
https://community.rsa.com/t5/archer/ct-p/archer

(Optional) Verify that you have downloaded the installer package correctly by comparing the
checksum values from your downloaded Archer files to the checksum values for your Archer
Platform version displayed on the download page.

. Use the Run as Administrator option to extract the installation package on the server to a location

that is accessible to other servers.

Back up the instance and configuration databases created during the server preparation process.
This process ensures that your data is current so that you can recover it if necessary.

Task 2: Stop all Archer Jobs

This task stops processing of new jobs while allowing currently running jobs to process. Jobs in
progress and their associated child jobs can finish processing.

1.

Run the Archer Control Panel as Administrator. The default Archer Control Panel installation
path is C:\Program Files\RSA Archer\Archer Control Panel\ArcherTech.ControlPanel.exe.

Go to the Servers tab.

a. From the Plugins menu, select Job Engine Manager.
b. Click Servers.

Click Discontinue Job Processing.

In the Actions pane, click Save.

Task 3: Stop all Archer services except Archer Configuration service

This process ensures that all Archer services are stopped but the RSA Archer Configuration service
continues to run.
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1. Run Windows Services as Administrator.
2. Scroll until the RSA Services appear.
a. Right click each Service in turn.
I Note: Do not select RSA Archer Configuration service.

b. Select Stop.

Task 4: Shut down Archer

This process prevents access to the Archer website during the upgrade.
1. Open a command prompt.
2. In the Open field, enter:

iisreset /STOP

3. Press Enter.

Task 5: Run the installer as Administrator

Run the installer on all web and services servers.

1. Open the installation folder, and right-click ArcherInstall.exe.
Select Run as Administrator.

Click OK.

Select the appropriate language for the installer to use.

Read the Diagnostics and System Data License.

Click Next.

A
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Task 6: Install all components

In addition to installing all components, this installer establishes the connectivity to the instance
database that typically resides on a different server.

Begin at the Archer - Installation Options page.

1. Verify that only desired components are selected.

Note: Make sure to select the same components previously installed before running the
upgrade. If running the installer against a specific component is required, ensure that the other
components installed on the same server are also selected—otherwise, the installer will
uninstall them.

Clearing the Services component results in all installed services except for the Configuration
Service and Advanced Workflow Service being uninstalled. Clearing the Advanced Workflow
Service results in that service being uninstalled.

* Web Application

e Services

e Instance Database

e Advanced Workflow
2. Click Next.

Task 7: Choose the x.509 certificate from store

You must select the same certificate as the one from your original installation of theArcher. For
more information, see X.509 Certificates.

Begin at the Archer - Choose Certificate page.

1. Verify that Use Current Certificate is selected and click Next.

Task 8: Configure Advanced Workflow HTTPS

Begin at the Archer - Specify HTTPS Binding Certificate page.

I Note: Advanced workflow requires a dedicated certificate.
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1. Enter the port to securely communicate with the Advanced Workflow Service in HTTPS Port.

2. Do one of the following:

Note: The port numbers for Advanced Workflow REST URL and Advanced Workflow
Communication Port cannot be the same when using HTTPS. For example by default, the
Advanced Workflow REST URL default port is 8443 and the Advanced Workflow
Communication default port is 8000.

e Use HTTPS.
° Specify where to obtain the X.509, by doing one of the following:

e If using current certificate, select Use current certificate.

I Note: This option is unavailable, if this is the first installation for your configuration.
e If selecting from a certificate store, do the following:

a. Select from certificate store.

b. In Select a certificate from the store, expand the category and select the certificate.

° Specify the HTTPS Port.

Note: If the system detects the specified port number is in use, you must confirm you
wish to replace the certificate bound to the specified port.

e Use HTTP only (Not recommended. When is option is selected, Archer uses the default port
and URL. This is not a secure option.)

3. Click Next.

Task 9: Set the REST URL and Communication Port for Advanced Workflow service

Begin at the ArcherAdvanced Workflow Settings page.
1. If using HTTP, click Next.

2. During HTTP, Archer uses default ports and URLs.
3. If using HTTPS, do the following:

a. Change Advanced Workflow REST URL to the same value specified when configuring
Advanced Workflow HTTPS. For example, https://hostName:8000/ where hostName is the
fully qualified domain name of the host where the Advanced Workflow Service is installed.
If there are multiple Advanced Workflow Service hosts, hostName is the FQDN name for the
load balancer and the port number refers to the port for which you have configured the load
balancer.

b. Change the Advanced Workflow Communication Port to a different port than you specified
when configuring Advanced Workflow HTTPS. (The default value is 8000).
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Note: If this is a new install, the system populates this field with information from the
certificate and HTTPS port used to configure Advanced Workflow HTTPS.

c. Click Next.

Task 10: Select the language for Archer and content

If you did not check the Instance Database box in Task 6, this task is skipped automatically.
Begin at the Archer Language page.

1. In Select the language for Archer, select the language that you want to use for Archer. By
default, the language is US English. The supported languages are English (US), Chinese
(Simplified), French, German, Italian, Japanese, Portuguese (Brazil), and Spanish (Latin
American).

2. Click Next.

Task 11: Set the instance database options

The installer detects whether more than one instance exists so that all Instance Database connections
can be upgraded at the same time. If the installer does not detect the Configuration service, it cannot
detect whether there are multiple instances.

Begin at the Archer- Instance Database Options page.

Note: Complete step 1 only when multiple instances exist. If the installer does not detect multiple
instances, it does not prompt for a database instance selection.

1. Do one of the following:

e If you want to upgrade each instance individually, go to step 2. By default, the Single
Database Instance (Recommended) option is selected. If you select this option, run the
installer to upgrade all other instances.

e If you want to update multiple instances at the same time, select Multiple Database Instances
(Advanced). Select the instances that you want to upgrade. The instances you select upgrade
one at a time.

2. In SQL Server, enter the server name. If the SQL Server is configured for a custom port, enter
[servername],[portID].

3. If you are using integrated security, do the following, otherwise go to step 4.
a. Select User integrated security.

b. In Database, enter the instance database.
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4. Click Next.

5. Click Yes or Yes to All. If you select Yes, you must confirm each database.

Task 12: Configure the Web Application options

Begin at the Archer - Web Application Options page.
1. In Website, select the destination site for the Archer Web Application.

2. Under Destination directory, verify that destination directory is set to the Web Application
installation:

 Install in the website's default application.
e Install in an IIS application.
3. Click Next.

4. Click Yes to confirm the destination directory.

Task 13: Set the services and application paths

The installer populates the paths with the applicable path from the existing installation.
Begin at the Archer - Services and Application Files page.

1. In Services, verify the path where the services are installed.

2. In Application Files, verify the path where the application files are installed.

3. In Program Group, verify that Create Archer group for all users is selected, and click Next.

Note: It is recommended that you do not install Web Application or products in the same virtual
directory or Root of Archer. Browsers send Cookies if more than one Web Application resides in
same space; this behavior may lead to passing Archer cookies to any other application installed in
same Root or Virtual Directory.
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Task 14: Set the path for the installer log file

Begin at the Archer - Log Location page.
1. In Log Path, verify the path where the log file is stored, and click Next.
2. Confirm whether to copy the application files. Do one of the following:

e To copy the application files, click Yes, and select the folder to which you want to copy the
application files.

e To continue without copying the application files, click No.

3. Click OK.

Task 15: Perform the installation

Begin at the Archer - Perform Install page.

1. Click Next.
The installer starts installing the applicable components. A progress bar opens.

2. Wait for the installer to complete installing the applicable components.

3. Click Finish.
The ArcherControl Panel opens.

Task 16: Start IIS on all Web Servers
Begin at a Command prompt on a Web Server.
1. Open a Command Prompt.

2. In the Open field, enter

iisreset /[START
3. Click Enter.

Task 17: Verify the instance configuration

Begin in Windows Services.

1. Start all Archer services, except RSA Archer Configuration Services which should already be
running.
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Note: If you are using Advanced Workflow, start the Archer Workflow server at the Web
Servers.

2. Go to Job Engine Manager in the Archer Control Panel, and start job processing.

a. Click the Server tab and clear the Discontinue Job Processing checkbox to start processing
jobs.

b. In the Actions pane, click Save.
3. On the Installation Settings tab, verify the Logging and Default Local and Time Zone settings.

4. Double click the default instance to view the instance settings on the right pane and go to each
tab to verify that all information in the configuration is correct.

5. Click Save.
6. Repeat steps 4 and 5 for all other instances.

7. On the dedicated Services Server, start all Archer services.

Upgrading the Services Servers

Upgrading the Services Server consists of installing the Services component. You must upgrade this
component on each server for the services role. This upgrade takes a few minutes and occurs
simultaneously during the installation of the Instance Database component.

Task 1: Prepare the installer package

1. Download the Archer installer package from Archer Community.
https://community.rsa.com/t5/archer/ct-p/archer

2. (Optional) Verify that you have downloaded the installer package correctly by comparing the
checksum values from your downloaded Archer files to the checksum values for your Archer
Platform version displayed on the download page.

3. Use the Run as Administrator option to extract the installation package on the server to a location
that is accessible to other servers.

4. Back up the instance and configuration databases created during the server preparation process.
This process ensures that your data is current so that you can recover it if necessary.
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Task 2: Stop all Archer Jobs

This task stops processing of new jobs while allowing currently running jobs to process. Jobs in
progress and their associated child jobs can finish processing.

1. Run the Archer Control Panel as Administrator. The default Archer Control Panel installation
path is C:\Program Files\RSA Archer\Archer Control Panel\ArcherTech.ControlPanel.exe.

2. Go to the Servers tab.
a. From the Plugins menu, select Job Engine Manager.
b. Click Servers.

3. Click Discontinue Job Processing.

4. In the Actions pane, click Save.

Task 3: Stop all Archer services except RSA Archer Configuration service.

This process ensures that all Archer services are stopped but the RSA Archer Configuration service
continues to run.

1. Run Windows Services as Administrator.
2. Scroll until the RSA Services appear.
a. Right click each Service in turn.
I Note: Do not select RSA Archer Configuration service.

b. Select Stop.

Task 4: Shut down Archer
This process prevents access to the Archer website during the upgrade.
1. Open a command prompt.
2. In the Open field, enter:
iisreset /STOP

3. Press Enter.
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Task 5: Run the installer as Administrator

Run the installer on all web and services servers.

1. Open the installation folder, and right-click ArcherInstall.exe.

Select Run as Administrator.

Click OK.

Select the appropriate language for the installer to use.

Read the license agreement, and select I accept the terms in the license agreement.
Read the Diagnostics and System Data License.

Click Next.

A

Task 6: Install the services component

Begin at the Archer - Installation Options page.

1. Verify that only desired components are selected.

I Note: When upgrading, options used in past installations are automatically selected.

e Services Server

2. Click Next.

Task 7: Choose the X.509 certificate from store

You must select the same certificate as the one from your original installation of theArcher. For
more information, see X.509 Certificates.

Begin at the Archer - Choose Certificate page.

1. Verify that Use Current Certificate is selected and click Next.

Task 8: Set the configuration services credentials

Begin at the Archer - Services Credentials page.
1. Verify that Use the specified account to run all services is selected.

2. In User Name, enter the user name in the following format: domain\user.
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3. In Password, enter the password for the domain user account.

4. Click Next.

Task 9: Set the services and application paths

The installer populates the paths with the applicable path from the existing installation.
Begin at the Archer - Services and Application Files page.

1. In Services, verify the path where the services are installed.

2. In Application Files, verify the path where the application files are installed.

3. In Program Group, verify that Create Archer group for all users is selected, and click Next.

Note: It is recommended that you do not install Web Application or products in the same virtual
directory or Root of Archer. Browsers send Cookies if more than one Web Application resides in
same space; this behavior may lead to passing Archer cookies to any other application installed in
same Root or Virtual Directory.

Task 10: Set the path for the installer log file

Begin at the Archer - Log Location page.
1. In Log Path, verify the path where the log file is stored, and click Next.
2. Confirm whether to copy the application files. Do one of the following:

e To copy the application files, click Yes, and select the folder to which you want to copy the
application files.

* To continue without copying the application files, click No.

3. Click OK.

Task 11: Perform the installation

Begin at the Archer - Perform Install page.

1. Click Next.
The installer starts installing the applicable components. A progress bar opens.

2. Wait for the installer to complete installing the applicable components.

3. Click Finish.
The ArcherControl Panel opens.
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Task 12: Start IIS on all Web Servers

Begin at a Command prompt on a Web Server.

1.
2.

Open a Command Prompt.

In the Open field, enter:
iisreset /START

Click Enter.

Task 13: Verify the instance configuration

Begin in Windows Services.

1.

Start all Archer services.
Note: If you are using Advanced Workflow, start the Archer Workflow server at the Web
Servers.

Go to Job Engine Manager in the Archer Control Panel, and start job processing.

a. Click the Server tab and clear the Discontinue Job Processing checkbox to start processing
jobs.

b. In the Actions pane, click Save.

At the Installation Settings tab, verify the global settings of the Archer. These settings are
Logging, and Default Local and Time Zone.

Select the default instance and go to each tab and verify that all information in the configuration
is correct.

Click Save if you have made changes to the instance configuration.
Repeat steps 4 and 5 for all other instances.

On the dedicated Services Server, start all Archer services.

Upgrading the Web Servers

Upgrading the web role consists of installing the Web Application and Services components on the
dedicated Web Server. You must upgrade these components on each server for the web role. The
Web Application component requires the connection to the Archer Configuration service.

This upgrade takes a few minutes and can occur simultaneously during the installation of the
Instance Database component, if applicable.
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Important: For additional information about system requirements, see System Requirements. Be
sure to install all required components before running the installer.

Task 1: Prepare the installer package
1. Download the Archer installer package from Archer Community.
https://community.rsa.com/t5/archer/ct-p/archer

2. (Optional) Verify that you have downloaded the installer package correctly by comparing the
checksum values from your downloaded Archer files to the checksum values for your Archer
Platform version displayed on the download page.

3. Use the Run as Administrator option to extract the installation package on the server to a location
that is accessible to other servers.

4. Back up the instance and configuration databases created during the server preparation process.
This process ensures that your data is current so that you can recover it if necessary.

Task 2: Stop all Archer Jobs

This task stops processing of new jobs while allowing currently running jobs to process. Jobs in
progress and their associated child jobs can finish processing.

1. Run the Archer Control Panel as Administrator. The default Archer Control Panel installation
path is C:\Program Files\RSA Archer\Archer Control Panel\ArcherTech.ControlPanel.exe.

2. Go to the Servers tab.
a. From the Plugins menu, select Job Engine Manager.
b. Click Servers.

3. Click Discontinue Job Processing.

4. In the Actions pane, click Save.

Task 3: Stop all Archer services except RSA Archer Configuration service

This process ensures that all Archer services are stopped but the RSA Archer Configuration service
continues to run.

1. Run Windows Services as Administrator.

2. Scroll until the RSA Services appear.
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a. Right click each Service in turn.

I Note: Do not select RSA Archer Configuration service.

b. Select Stop.

Task 4: Shut down Archer

This process prevents access to the Archer website during the upgrade.
1. Open a command prompt.
2. In the Open field, enter:

iisreset /STOP

3. Press Enter.

Task 5: Run the installer as Administrator

Run the installer on all web and services servers.

1. Open the installation folder, and right-click ArcherInstall.exe.

Select Run as Administrator.

Click OK.

Select the appropriate language for the installer to use.

Read the license agreement, and select [ accept the terms in the license agreement.
Read the Diagnostics and System Data License.

Click Next.

A

Task 6: Install the web components

Begin at the Archer - Installation Options page.

1. Verify that only desired components are selected.

I Note: When upgrading, options used in past installations are automatically selected.
e Web Application
e Services Server
e Advanced Workflow
2. Click Next.
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Task 7: Choose the X.509 certificate from store

You must select the same certificate as the one from your original installation of theArcher. For
more information, see X.509 Certificates.

Begin at the Archer - Choose Certificate page.
1. Verify that Use Current Certificate is selected and click Next.

Task 8: Configure Advanced Workflow HTTPS

Begin at the Archer - Specify HTTPS Binding Certificate page.
I Note: Advanced workflow requires a dedicated certificate.
1. Enter the port to securely communicate with the Advanced Workflow Service in HTTPS Port.

2. Set up HTTPS (it is not recommended to use HTTP). (The protocol and port numbers set here
must be used in the next task.)

a. Specify where to obtain the X.509. Do one of the following:

¢ [f using current certificate, select Use current certificate. (This option is unavailable, if
this is the first installation for your configuration.)

e If selecting from a certificate store, do the following:
a. Select from certificate store.
b. In Select a certificate from the store, expand the category and select the certificate.

b. Specify the HTTPS Port. (If the system detects the specified port number is in use, you
must confirm you wish to replace the certificate bound to the specified port.)

3. Click Next.

Task 9: Set the URL for the Advanced Workflow service

Begin at theArcher Advanced Settings page.

1. Change the value to http://hostName:8000/ where hostName is the fully qualified domain name
of the host where the Advanced Workflow Service is installed. If there are multiple Advanced
Workflow Service hosts, hostName is the DNS name for the load balancer and the port number
refers to the port for which you have configured the load balancer.

2. Click Next.
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Task 10: Set the REST URL and Communication Port for Advanced Workflow

service

Begin at the ArcherAdvanced Workflow Settings page.
1. If using HTTP, click Next.

2. During HTTP, Archer uses default ports and URLs.
3. If using HTTPS, do the following:

a. Change Advanced Workflow REST URL to the same value specified when configuring
Advanced Workflow HTTPS. For example, https://hostName:8000/ where hostName is the
fully qualified domain name of the host where the Advanced Workflow Service is installed.
If there are multiple Advanced Workflow Service hosts, hostName is the FQDN name for the
load balancer and the port number refers to the port for which you have configured the load
balancer.

b. Change the Advanced Workflow Communication Port to a different port than you specified
when configuring Advanced Workflow HTTPS. (The default value is 8000).

Note: If this is a new install, the system populates this field with information from the
certificate and HTTPS port used to configure Advanced Workflow HTTPS.

c. Click Next.

Task 11: Select the language for Archer and content

If you did not check the Instance Database box in Task 6, this task is skipped automatically.
Begin at the Archer Language page.

1. In Select the language for Archer, select the language that you want to use for Archer. By
default, the language is US English. The supported languages are English (US), Chinese
(Simplified), French, German, Italian, Japanese, Portuguese (Brazil), and Spanish (Latin
American).

2. Click Next.

Task 12: Configure the Web Application options

Begin at the Archer - Web Application Options page.
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1. In Website, select the destination site for the Archer Web Application.

2. Under Destination directory, verify that destination directory is set to the Web Application
installation:

e Install in the website's default application.
e Install in an IIS application.
3. Click Next.

4. Click Yes to confirm the destination directory.

Task 13: Set the services credentials

Begin at the Archer - Services Credentials page.

1. Verify that Use the specified account to run all services is selected.

2. In User Name, enter the user name in the following format: domain\user.
3. In Password, enter the password for the domain user account.
4

. Click Next.

Task 14: Set the services and application paths

The installer populates the paths with the applicable path from the existing installation.
Begin at the Archer - Services and Application Files page.

1. In Services, verify the path where the services are installed.

2. In Application Files, verify the path where the application files are installed.

3. In Program Group, verify that Create Archer group for all users is selected, and click Next.

Note: It is recommended that you do not install Web Application or products in the same virtual
directory or Root of Archer. Browsers send Cookies if more than one Web Application resides in
same space; this behavior may lead to passing Archer cookies to any other application installed in
same Root or Virtual Directory.
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Task 15: Set the path for the installer log file

Begin at the Archer - Log Location page.
1. In Log Path, verify the path where the log file is stored, and click Next.
2. Confirm whether to copy the application files. Do one of the following:

e To copy the application files, click Yes, and select the folder to which you want to copy the
application files.

e To continue without copying the application files, click No.

3. Click OK.

Task 16: Perform the installation

Begin at the Archer - Perform Install page.

1. Click Next.
The installer starts installing the applicable components. A progress bar opens.

2. Wait for the installer to complete installing the applicable components.

3. Click Finish.
The ArcherControl Panel opens.

Task 17: Start IIS on all Web Servers

Begin at a Command prompt on a Web Server.
1. Open a Command Prompt.

2. In the Open field, enter:
iisreset/START

3. Click Enter.

Task 18: Verify the instance configuration

Begin in Windows Services.

1. Start all Archer services.

Note: If you are using Advanced Workflow, start the RSA Archer Workflow server at the Web
Servers.
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2. Go to Job Engine Manager in the Archer Control Panel, and start job processing.

a. Click the Server tab and clear the Discontinue Job Processing checkbox to start processing
jobs.

b. In the Actions pane, click Save.

3. At the Installation Settings tab, verify the global settings of the Archer. These settings are
Logging, and Default Local and Time Zone.

4. Select the default instance and go to each tab and verify that all information in the configuration
is correct.

5. Save if you have made changes to the instance configuration.
6. Repeat steps 4 and 5 for all other instances.

7. On the dedicated Services Server, start all Archer services.
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Chapter 4: Activating Archer

This chapter guides you through activating your Archer configuration after a new installation or an
upgrade, and configuring Advanced Workflow, if necessary.

e Activation process for a new installation
e Activation process for an upgrade

e Configuring advanced workflow

Use the Post-Installation Worksheet to record your system configuration.

Activating an Archer Installation

After completing a fresh installation of Archer, use this section to configure your environment
properly.

Activation Process for an Install

To complete your installation of Archer, configure your environment and activate your servers.
Activating servers is the process of ensuring files specific to Archer have the proper permissions and
can be accessed by the applicable service.

Activate your Archer installation in the following phases:

Phase What to do Reference

1 Use the Archer Control Panel to Archer Control Panel Help:
?onﬁgure the global se.rttings for Archer « "Configuring Logging Rules"

in the Installation Setting tab.
e "Configuring the Default Locale and

Time Zone"

2 Use the Archer Control Panel to do one | Archer Control Panel Help:

of the following: e "Instance Configuration Settings"

e In the case of a vanilla installation,
create an Archer instance and set it as
the default instance by selecting the
"Enable a default instance" checkbox
in Installation Settings.

e "Completing the Default Creation"

e "Setting the Default Instance"

* In the case of an upgrade, connect to
the existing instance.
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Phase What to do Reference

3 Activate the Services Server by starting = Configuring the Services Server

the Archer services and verifying
permissions to the domain account and
X.509 certificate, for multiple-host
installations.

4 Activate the Web Server by granting Configuring the Web Server

permissions to the Archer directories
and assigning the application pool to the
website.
Keep the following in mind as you complete the verification process:
e Create your default instance.
e Register your license on your main Web Server.
e Start all Archer services on your main Services Server.
e Start the Archer Configuration service on every Web Server.
e Make sure your Network Share has the appropriate files in it.

e Map Network Share on every server.

Creating the Archer Instance

You create instances in the Archer Control Panel and then designate one of them as the default

instance for all users. Each task references the applicable topic from the Archer Control Panel Help

to guide you through this process.

Task 1: Start the Archer Queuing service

1. Go to Start > Services to open the Services window.

2. In the Archer Queuing list, verify that the Archer Queuing service is running.

 If the service is running, skip to Task 2.

e [f the service is not running, continue to Step 4.
3. Right-click Archer Queuing.
4. Click Start.
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Task 2: Create the default Archer instance

Complete all tasks. See the Archer Control Panel Help on Instance Settings for step-by-step help.
Access the Archer Control Panel Help by clicking the question mark icon in the upper right hand
corner.

Instance Tab Required
General Configuring an Instance for Notifications
(Default From Address)

Configuring Logging Rules (Override)

Configuring the Default Locale and Time Zone
(Override)

Designating the File Repository Path for an
Instance

Designating Search Index Path and the
Queuing Server for an Instance

Web Designating the Base and Authentication URLs
for the Web Application
Database Configuring the Instance Database Connection

String and Pooling Options

Accounts Changing SysAdmin and Service Account
Passwords

Running the Maintenance SQL Script

Use a SQL script to maintain the Archer database if your organization does not have its own
standard process for maintaining Microsoft SQL database indexes and statistics. This script creates
the Archer Database Statistics Update job to update statistics and the Archer Database Index Rebuild
job to re-index the database.

For best results, schedule these jobs to run during inactive periods. For example, you can schedule
the Statistics Update job to run every day at 3:00 AM and the Index Rebuild job to run every Sunday
at 2:00 AM.

I Note: The SQL Server Agent must be running before you can execute the script.

Run the Maintenance SQL Script

1. Log in as a system administrator to the server that hosts the Archer database.

2. Navigate to the \RSA Archer\Tools\ folder.
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3. Double-click jobDeployScript.sql.
4. Select the Archer database as the current database.

5. Execute the script, which creates the Statistics Update and Index Rebuild database jobs.

Configuring the Web Server

Important: Ensure that the configuration files on each server share the same machineKey. This
key uses encryption and needs to be the same on each Web Server to ensure proper key
generation. For more information, see Configuring a Load Balancer for Archer.

Perform these steps in the Internet Information Services (IIS) manager, unless otherwise specified.

Task 1: Specify the account application pool identity

1. In the IIS Manager, go to the Web Server > Application Pools.
2. Right-click the application pool for Archer, and select Advanced Settings.
3. In Identity under Process Model, click the Ellipsis (...) at ApplicationPoolldentity.
4. Click Custom Account, and click Set.
5. Enter appropriate values for the following:
e User Name
e Password
e Confirm Password
6. Click OK, and then click OK again.
7. Click OK.

Task 2: Assign the application pool

Note: When assigning the application pool, select the Archer website for your company. The
website may reside on a virtual directory. These instructions reflect choosing the Default Web
Site.

1. In the IIS Manager, go to Web Server > Sites > Default Web Site > website, for example Archer.

2. Right-click on website and select Manage Application > Advanced Settings.

3. In the General section, click Application Pool and E

4. In Application pool, select the applicable application pool, and click OK.
5. Click OK.
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Go to Web Server > Application Pools.

Right-click the applicable application pool > Advanced Settings.
In the General section, select v4.0 for NET CLR Version.

Click OK.

o ® =N

Task 3: Verify application pool for the API

The API must run under or have the same configuration as the application pool of the website.
Follow these steps to configure the application pool for the API, the Content API, as well as the
Platform API:

1. In the IIS Manager, go to Web Server > Sites > Default Web Site > website. For example,
Archer.

Expand the website node and go to the api node.
Right-click on the node to configure and select Manage Application > Advanced Settings.

In General, verify that the Application Pool is the same as the website.

A A

Do one of the following:

* If the application pool matches the website, go to the Step 6.

 If the application pool does not match the website, do the following:
a. In Application Pool, click the Ellipsis ( ... ) button
b. Select the application pool of the website, and click OK.

Click OK.

5

Task 4: Reconfigure the company_files directory as a virtual directory that is mapped to the
network share
Complete this task if your configuration has multiple Services Servers.

Configure the virtual directory for the company files after the initial installation in a multiple-host
configuration. You must reconfigure the company files directory as a virtual directory that is
mapped to the network share.

1. On the network share, create the company _files directory and copy all directories from the local
company_files folder to the newly created company _files folder. For example,
Inetpub\wwwroot\RSAarcher\company files.

2. Rename the original company _files directory to company _files.old.

3. Set the share properties on the company _files directory to Modify/Change and Read/Write on
both Sharing and Security permissions tabs of the domain account.
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4. In the IIS Manager, navigate to the Add Virtual Directory dialog box.
a. Click Web Server >Sites > Default Web Site > RSA Archer.
b. Right-click on Archer website and select Add Virtual Directory.
5. In Alias, enter company _files.

6. In Physical Path, enter the path of the new created company _files on the network share, and click
Connect as.

7. Select Specific user, and click Set.

8. In User name, enter the domain user account.

9. In Password, enter the password of the domain user account.
10. In Confirm password, re-enter the password of the domain user account, and click OK.
11. Click OK.
12. Click OK again.

Task 5: Grant permissions to the Archer directories

Complete this task if your configuration has multiple Services Servers.

Complete this task for all configurations for the Web Application on the network share. Begin at
Internet Information Services (IIS) Manager.

Verify that the Identity has Modify privileges for the following folders:

Directory Path Notes
Windows\Te SYSTEMDRIVE%\WINDOWS\
mp Microsoft. NET\Framework64\v4.0.30319\
Temporary ASP.NET Files
company designated path on the Web Server or For the company _files, Log
files network share files, Search Index, and File
Repository, use the actual path
for your configuration.
For example,
Inetpub\wwwroot\RSAarcher\co
mpany_files
Log Files designated path on the Web Server or For example,
network share .\RSAarcher\LogFiles
File designated path on the Web Server or For example,
Repository network share .\RSAarcher\FileRepository

Chapter 4: Activating Archer 64



Archer Platform Installation and Upgrade Guide

Task 6: Reset IIS
1. Go to Start > Run.
2. In the Open field, enter:

iisreset.exe

3. Press Enter.

Task 7: Exclude folders from virus scanning (Recommended)

It is recommended that you routinely run virus scanning software on the deployed servers. However,
virus scanning software can interpret data inserted or updated in Archer dependent directories as a
virus or malware, for example, as with the Archer Threat Management solution.

1. Disable virus scanning on the folders that contain the following files:
e Windows\Microsoft.Net\Framework64
e Archer Company Files
e Archer Log Files
e Archer Index
e Archer File Repository

2. Disable virus scanning on the RSA Archer\Services\Workpoint\ folder in the Archer program
files, to prevent server performance degradation with some anti-malware solutions.

For additional information on "Virus Scanning," see the Security Configuration Guide.

Configuring the Services Server

On a fresh install, configuring the Services Server requires starting the Archer services.

Task 1: Verify the domain user account has access to network share and company_file dir-
ectories on the network share
1. Ensure that the log file is on a local drive and not the network share.

2. From Archer Control Panel, verify the path to Logging on the Installation Settings tab. Make
certain that the log file is on a local drive and not the network share.

3. In Explorer, verify that the Domain Account has Modify or Read/Write permissions.

4. Navigate to the network share and verify that the following folders have Modify or Read/Write
permissions.
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e File Repository
e company_files

¢ Indexes

Task 2: Verify the X.509 certificate permissions

This task ensures that the service account used by the services have Read permissions to the relevant
X.509 certificate private key. This certificate was specified during the initial installation. For more
information, see X.509 Certificates.

L.

10.

11.
12.

A R

Start the Microsoft Management Console (MMC). Do the following:
a. Click Start and Run.
b. In Open, enter :
mmc
c. Click OK. The Console Root window opens.
Click File > Add/Remove Snap-In.
In Available snap-ins, select Certificates and click Add.
Select Computer account and click Next. The Select Computer dialog box opens.
Select Local computer (the computer this console is running on), and click Finish.
Click OK.

Expand the Certificates (Local Computer) and the Personal folder, and click Certificates. If the
certificate was created during the initial installation, the Archer Configuration certificate is listed.

Right-click Archer Configuration or the certificate specified during the installation and click All
Tasks > Manage Private Keys.

In Group or User Names, do one of the following:
e If the account is listed, go to the next step.
e If the account is not listed, do the following:
a. Click Add.
b. In Enter the object names to select, enter the applicable object names, and click OK.
In Permissions for [account], do the following:
a. At Full control, clear the Allow checkbox.
b. At Read, select the Allow checkbox.
Repeat steps 9 and 10 for each account running the Archer Services.

Click OK, save and close the Console window.
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Task 3: Make the certificate revocation list accessible

Each time a job process starts, it validates the Certificate Revocation List (CRL). If a Archer server
does not have direct internet access, making the CRL distribution point inaccessible, a 15-second
timeout occurs before the process can to continue. This timeout can introduce a significant delay for
each job process that the Job Engine service starts.

To eliminate the 15 second delay, complete one of the following tasks:

Disable the certificate revocation list validation

Complete this task to disable CRL validation for the user account running the Job Engine service.
Disabling CRL validation does NOT disable signature verification. The signing certificate still
matches against the trusted root store.

1. Open Command Prompt.
2. Enter:
wmic useraccount get name,sid
3. Click OK.
4. Find the SID for user account running Job Engine.
a. At the Command Prompt, enter:
RegEdit

b. Go to HKEY USERS > [SID of user account running Job Engine] > Software > Microsoft >
Windows > CurrentVersion\WinTrust\Trust Providers > Software Publishing.

c. In the right pane, double-click State.

d. Change Value data (Hexadecimal) from 23c00 (default, checking enabled) to 23e00
(checking disabled).

5. Click OK.
Set a system-level HTTP proxy

Complete this task to set a system-level HTTP proxy so that any user who logs in to the system has
Internet access without having to take another action. This situation may not be desirable behavior.

1. Open Command Prompt.

2. Enter:
netsh winhttp set proxy proxy-server="[MyProxyServer:port]” bypass-list="<local>,”
where [MyProxyServer:port] is populated with an actual proxy server and port number.

3. Press Enter.
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Activating an Archer Upgrade

After completing an upgrade of Archer, use this section to configure your environment properly.

Activation Process for an Upgrade

To complete your upgrade of Archer, configure your environment and activate your servers.
Activating servers is the process of ensuring files specific to Archer have the proper permissions and
can be accessed by the applicable service.

It is accomplished in the following phases.

Phase

1

What to do

Use the Archer Control Panel to do one
of the following:

e In the case of an install, create the
default Archer instance, including
setting the default instance

 In the case of an upgrade, connect to
the existing instance

Create the Archer Database Statistics
Update job to update statistics and the
Archer Database Index Rebuild job to
re-index the database.

Activate the Archer instance by
registering the license, starting the
Archer services and rebuilding the
search indexes.

Reference

Archer Control Panel Help:

e "Instance Configuration Settings"
e "Completing the Default Creation"
e "Setting the Default Instance"

Running the Maintenance SQL Script

Activating the Instance
Archer Control Panel Help:
e "Registering the Instance"

e "Rebuilding Search Indexes"

Keep the following in mind as you complete the verification process:

e Register your license on your main Web Server.

e Start all Archer services on your main Services Server.

¢ Start the Archer Configuration service on every Web Server.

Activating the Archer Instance

Activating the instance requires you to register your Archer license and to rebuild search indexes.

The RSA Archer Queuing service must be running to rebuild the search indexes.
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Task 1: Use the Archer Control Panel to license your Archer software

Refer to the topic "Registering the Instance" in the Archer Control Panel Help for complete
instructions.

Task 2: Restart the RSA Archer Queuing Service

This step is required when registering your first instance. Go to the next step for subsequent
registrations.

Begin at the Services window.
1. Locate Archer Queuing in the list.
2. Right-click Archer Queuing, and click Restart.

Task 3: Use the Archer Control Panel to initialize the search indexes

See "Rebuilding Search Indexes" in the Archer Control Panel Help for complete instructions.

Running the Maintenance SQL Script

Use a SQL script to maintain the Archer database if your organization does not have its own
standard process for maintaining Microsoft SQL database indexes and statistics. This script creates
the Archer Database Statistics Update job to update statistics and the Archer Database Index Rebuild
job to re-index the database.

For best results, schedule these jobs to run during inactive periods. For example, you can schedule
the Statistics Update job to run every day at 3:00 AM and the Index Rebuild job to run every Sunday
at 2:00 AM.

I Note: The SQL Server Agent must be running before you can execute the script.

Run the Maintenance SQL Script

1. Log in as a system administrator to the server that hosts the Archer database.
2. Navigate to the \RSA Archer\Tools\ folder.

3. Double-click jobDeployScript.sql.

4. Select the Archer database as the current database.

5

. Execute the script, which creates the Statistics Update and Index Rebuild database jobs.

Install the Admin Dashboard Package

When upgrading, it is necessary to install the Admin Dashboard Package. For more information, see
"Admin Dashboard" in the Archer Online Documentation.

To enable all features and iViews of the Admin Dashboard, you must import and install the Admin
Dashboard package.
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Note: In the Archer Control Panel, system administrators can edit the run frequency and data
retention period. The Admin Dashboard job status can be managed and the job removed from and
re-added to the Job Engine.

Task 1: Import and map the Admin Dashboard package

1.

6.

On Archer Community, download the Admin Dashboard package file.

From the menu bar, click ‘\ > Application Builder > Install Packages.

In the Available Packages section, click Import.

Click Add New, then locate and select the Admin Dashboard package file.

Click OK.

The package file is displayed in the Available Packages section and is ready for installation.

Note: Only the package file has been imported; you must map and install the package file to
migrate the components to your instance of Archer.

In the Actions column, click o for that package.

Task 2: Install the Admin Dashboard package

. In the Actions column, click #" .

In the Selected Components section, select the components of the package that you want to
install.

e To select all components, select the top-level checkbox.

» To install only specific global reports in an already installed application, select the checkbox
associated with each report that you want to install.

Note: Items in the package that do not match an existing item in the target instance are
selected by default.

In the Selected Components section, click Lookup.

(Optional) In the Translation Option field, select an option for each selected component.
I Note: The Translation Option field is enabled only when a language is selected.

In the Install Method and Install Option fields, select one of the following options for each
selected component, and click OK.

e Create New Only

e Create New and Update

e Override Layout(s)

e Do not Override Layout(s)
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6. Click Install.
7. Click OK.

8. Review the Package Installation Log.

Configuring Advanced Workflow

If you plan to use the Advanced Workflow feature, you may have to perform additional
configuration activation, depending on your environment. Review the following tasks and complete
any that are applicable to your environment.

Task 1: Open HTTP on localhost for communication between the Advanced

Workflow service and Archer

HTTP communication is used between the Archer middle tier and the Archer Advanced Workflow
Service. If you have currently disabled HTTP communication, and want to use the Advanced
Workflow feature, on the server running the Archer Advanced Workflow Service, add exceptions for
TCP port 8000 in your local firewall or other tools.

Task 2: Run the Advanced Workflow service with a non-admin account

By default, the Advanced Workflow service runs as administrator. However, if you do not want to
run the service with admin or local system privileges, you can run the service under a different
account that has the following permissions:

Directory Access Required

C:\Program Files\RSA Read/Write
Archer\Services\Workpoint

C:\ArcherFiles\Logging Write

The directory that the %TMP% or %TEMP% Read/Write
environment variables point to for the account.
To change the service account, do the following:
1. Open the Services Control Manager.
2. Right-click the Advanced Workflow service, and select Properties.
3. Click the Log On tab, and select This account.
4

. Select the user you want to use, enter the credentials, and click OK.
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Task 3: (Optional) Enable Advanced Workflow in a load balanced environment

If you are running Archer with a load balancer, ensure that all of the internal servers running IIS and
the Advanced Workflow service can communicate through port 8000.

This is set in the Archer Control Panel.

Additionally, you may force the Advanced Workflow service to honor currently configured proxy
settings.

Task 4: Ensure Windows host registry key is valid

1. Open Regedit.exe.

2. Confirm the following registry key stores the Advanced Workflow configuration information:
HKEY LOCAL MACHINE\SOFTWARE\Workpoint LLC\Workpoint\x.x
where x.x is the Workpoint version number installed in your environment.

3. Confirm the ServerAddress stores the hostname for the server.

Important: If the Windows host is renamed, Advanced Workflow does not synchronize correctly
until the property is updated.

Enabling Elasticsearch

Elasticsearch improves how quickly data gets indexed.

Enable Elasticsearch

1. Open the Archer Control Panel, and go to the Installation Settings tab.
On the General tab, go to the Elasticsearch section.

In the Elasticsearch field, select Enable Elasticsearch.

In the Elasticsearch Cluster field, click Add.

In the Cluster Name field, enter the cluster name and click OK.

Next to the Elasticsearch Node IP Configuration field, click Add New.

A

In the Enter URL field, enter the complete URL for the Elasticsearch Node IP and click OK.
By default, Elasticsearch listens to port 9200. This port can be configured in the configuration

file of Elasticsearch. For a secure connection to Elasticsearch, you must use 'https' (for example,
https://1.1.1.1:9200).
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8.

9.

To test the availability of the IPs, select the desired URL from the Elasticsearch Node IP
Configuration field and click the Test Availability link below. Enter the username and password
to authenticate and click Submit.

The values for the user name and password entered are used by the system to authenticate and
are not stored in a database. If you want to store these values, see "Store authentication
information for instances" below.

On the toolbar, click Save.

Note: If Elasticsearch is enabled, searches containing a hyphen (-) are not indexed as a single
word. Due to this, an inaccurate number of search results may return.

Note: Even with Elasticsearch enabled, statistics mode searches use SQL queries to obtain
results. For more information, see "Running Searches in Statistics Mode" in the Archer Online
Documentation.

Store authentication information for instances

Enabling authentication allows you to store authentication information used to connect with the
selected Elasticsearch cluster for the particular instance.

1.

Go to the Search Index section for the instance.

a. From the Instance Management list, double-click the instance for which you want to enable
authentication.

b. On the General tab, go to the Search Index section.
In the Elasticsearch field, select Check this flag to use Elasticsearch as search data source.
From the Cluster Name drop-down list, select the cluster.

Select Enable Authentication and enter the user name and password that are used to connect
Archer with Elasticsearch for this instance.

On the toolbar, click Save.
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Chapter 5: Validating Archer

This chapter guides you through validating the components of your Archer configuration. Use this
with the Validation Checklist in Appendix D.

Platform System Validation

The validation process ensures that you have properly configured and activated system components
for Archer and that key elements of the Archer function for your business operations.

The information in this chapter enables you to validate basic functionality. It is recommended to
develop a more robust test plan to meet your specific business practices. Test any other features that
you are using. For example, if notifications are a major part of your workflow, test this functionality.
For additional information about getting your system operational, see the Archer Online
Documentation.

Validating Archer Elements

Validate the Archer elements to ensure that you have configured your instance correctly, including
the search indexes, file repository, and company files.

As part of this validation, you must add a new application, enter records, test a keyword search, and
attach a file to a record. If you plan to use advanced workflow functionality, you also create a test
workflow in your application. Each task references the applicable topics from Archer Online
Documentation to guide you through this process.

Task 1: Open Archer and log in as system administrator

Step Action Results
1 Start the browser, for example IE, and This URL is established in the Web
enter the Base URL to the Archer. settings in the Archer Control Panel.
2 Log in to the Archer as system
administrator:

a. In User Name, enter sysadmin.
b. In Company, enter the instance name.

c. In Password, enter the password.
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Step Action Results

3 Click Login. The Archer page opens.

If you do not see the Login page, see
Troubleshooting System Components.

Task 2: Add and test a new application using Application Builder

Step Action Results

1 Create a new application from scratch.

For information on creating new applications, see the topic "Adding
Applications" in the Archer Online Help.

2 Add the following field types: Each added

o Text with Search Results enabled field is listed

on the Manage

e Attachment Fields page.

e Values List with three or more values

For information on adding field types, see the topics "Adding a
Text Field", "Adding an Attachment Field", and "Adding a Values
List Field" in the Archer Online Help.

3 Add the newly created fields to the layout.

For information on adding fields to a layout, see the topic "Adding
Fields to the Layout" in the Archer Online Help.
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Step

Action Results

(Optional) Build and activate a simple advanced workflow with the
following settings:

e Nodes: Start, Stop, and Update Content. Set the Update Content
node to update a value in a field. (Creating a test record enables
you to determine if the workflow you have built is valid).

e Enrollment option: New.

Important: Make sure that you activate the workflow.
Workflows are created as inactive by default.

For information on building and activating advanced workflows,
see the topic "Building Advanced Workflows" in the Archer Online
Help.

Note: You only need to complete this step if you plan to use the
advanced workflow functionality.

Save the application. The newly
created
application is
listed on the
Manage
Applications

page.

Go to your home page and open the application that you created. The Search
Results page
opens for that
application.

For information on working with records, see the topics called
"Working with Records" in the Archer Online Help.
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Step Action Results

7 Add two new records to the application and save. The new
records appear
in the Search
Results page of
the application.

If you created
an advanced
workflow,
fields in the
record are
updated
according to
your design.

Task 3: Test keyword indexes by performing a keyword search

Step Action Results

1 Go to the Search Results page for the The Search Results page opens for that
application you created. application.

2 Run a Keyword Search using text entered | Records found from the search are listed
in one of the records created in the test on the Search Results page.
application.

For information on keyword searches, see "Running Searches in Applications and Questionnaires"
and "Search Options: Keywords and Phrases" in the Archer Online Help.

Task 4: Validate the path to the File Repository folder by adding an attachment to a

record
Step Action Results
1 Locate a file that you can attach to a

record.
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Step

5

Action

Go to the Search Results page for the
application you created.

Navigate to the Attachment section, and
click Add New.

Attach the file to the record.

Click the link to the attachment.

Results

The newly attached file is a link on the
record.

The attachment file opens.

For information on working with attachments, see "Working with Records" and "Data Entry" in the
Archer Online Help.

Task 5: (Optional) Test Advanced Workflow

Step
1

5

Action

Log in to the Archer as system
administrator:

a. In User Name, enter sysadmin.

b. In Company, enter the instance name.

c. In Password, enter the password.
Go to the Application Builder.

Open an application that has Advanced
Workflow.

Build an Advanced Workflow.

Run the Advanced Workflow

Results

The application has advanced workflow
tab.

The nodes and transitions can be added
properly.

The workflow functions as expected.

For information on working with advanced workflow, see "Building Advanced Workflows" in the
Archer Online Documentation..

Troubleshooting System Components

If you cannot access Archer at the login page, use the following tasks to troubleshoot the system

components.
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Validating Server Settings

Task 1: Validate IIS settings

The procedures for validating these settings depends on the version of IIS installed in your
environment. See the Archer Qualified and Supported Environments document on the Archer
Community for the supported version of Microsoft Internet Information Services (IIS) and the .NET

framework.
Step Action Results
1 Verify that the ASP.NET is set to ISAPI and CGI Restrictions
Allowed.
2 Verify that only one authentication Sites > Default Web Site > RSAarcher >
option is set for the default web site. Authentication

Task 2: Validate Web Server folder access

Thi

s test verifies that Network Service user account has access to the logging folder, the file

repository folder, and the company _files folder. The paths to the file repository and logging folders

arc

set in the General tab of the instance in the Archer Control Panel. The path to the company_files

folder was set during the installation of the Archer component.

1.
2.

Open a Microsoft Explorer window.

Navigate to the logging folder. The default path is:
C:\Program Files\RSA Archer\Logfiles
Right-click the logging folder and click Properties.
Click the Security tab.

Select the Network Service or domain service account and verify that Modify is selected in the
Permissions box.

Click OK.
Repeat steps 1 — 6 for the file repository folder. The default path is:
C:\Program Files\RSA Archer\FileRepository

Repeat steps 1 — 6 for the company _files folder. The path to this folder was set during the
installation process. The default path is:

C:\Inetpub\wwwroot\RSA Archer\company_files

Troubleshooting Archer Advanced Workflow

This section assumes that you selected advanced workflow as part of your installation.
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If you cannot access the advanced workflow functionality in the Application Builder or your test
workflow fails, use the following tasks to troubleshoot the Advanced Workflow service installation

and configuration.

Note: Most of these tasks require access to the server on which Archer Advanced Workflow
service was installed. If you do not have access, contact your system administrator.

Advanced workflow installation overview

Advanced workflow runs as a Windows service with other services on a Web Server. Alternatively,
you can dedicate a Web Server to advanced workflow.

In a new installation, the following occurs:

1. The Advanced Workflow service is installed.

2. The service communicates with the Configuration service to get instance settings and updates the

workflow server configuration with the settings.

Advanced workflow is ready to communicate with the Web Application.

Advanced workflow suggested settings

Advanced workflow runs as a Windows service with other services on a Web Server or Services
Server. Alternatively, you can dedicate Services Server to advanced workflow. The process occurs
during install. In a new installation, the following Application Request Routing cache settings

populate in the IIS:
Field

Enable Proxy

HTTP Version

Keep alive

Time-out (seconds)

Reverse rewrite host in response headers
Preserve client IP in the following header
Include TCP port from Client IP
Memory Cache duration (seconds)

Enable disk cache

Query string support
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Troubleshooting process overview

Step Question to How to find out Result Action
answer

1 Can Microsoft a. Log in to Archer. If the page Go to step 2.
Internet . From the menu bar, loads, the
Information test passed.

Services (IIS) click o‘ .
cqmmumcate . Under Advanced
with the Workflow, select
Advanced Job Troubleshooting.
Workflow
service?
If the page Go to
does not Troubleshoot
load or communication.
renders an
error page,
the test
failed.

2 Is the Advanced = Open the Windows service | The service = Go to
Workflow Control Manager and see is running. Troubleshoot the
service running? | if the Archer Advanced Advanced

Workflow service is Workflow
running. application server
deployment.

The service
exists, but
is not
running.

The service
does not
exist.

Start the service.

Go to
Troubleshoot the
Advanced
Workflow service.

Troubleshoot the communication between IIS and the Advanced Workflow service

1. Open IIS Manager and, at the global server level, verify that the Application Request Routing

module exists. If the module does not exist, do the following:

Chapter 5: Validating Archer



Archer Platform Installation and Upgrade Guide

a. Reboot your system. See if the module now exists.

b. If that does not work, repeat the installation. On the Installation Options page, verify that
only Advanced Workflow Service is selected.

Open the Application Request Routing module.

In the Cache Setting section, verify that Enable Disk Cache is selected. If not, select it and click
Apply.

In IIS, verify that the WebDAYV feature is disabled for your Archer site. If it is enabled, disable
it. Archer does not support the WebDAV feature.

Open Archer Control Panel. Navigate to the Install Settings page and the Advanced Workflow
frame. Ensure the Workflow Host or Load Balancer URL match the values used for Advanced
Workflow REST URL and Advanced Workflow Communication Port during the installation
process.

If you are encrypting advanced workflow, verify that a dedicated certificate was imported
properly into the local machine's personal store. See Preparing Encryption for Advanced
Workflow for more information.

Troubleshoot the Advanced Workflow Service

1.

Verify that the Advanced Workflow service was created:

C:\Program Files\RSA Archer\Services\ArcherTech.Services. WorkflowService.exe
Verify that the following directory was created:

C:\Program Files\RSA Archer\Services\Workpoint

If any of the above were not created, repeat the installation.

Troubleshoot the Advanced Workflow application server deployment

L.

In the Task Manager, verify that the following are running:
e WpAsyncMonitor.exe

e WpEventMonitor.exe

e WpGeneralMonitor.exe

e WplobMonitor.exe

e WpServiceHost.exe

Check the service wrapper log file for errors in the file
C:\ArcherFiles\Logging\Archer.ArcherTech.Services. WorkflowService.date.xml.
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3. If you have enabled logging in the Archer Control Panel, open C:\ArcherFiles\Logging and
check whether or not the ArcherAdvancedWorkflow.xml file exists. If it does not, contact
Support.

Note: C:\ArcherFiles is a configurable field in the Archer Control Panel. For more information see
the Archer Control Panel documentation.

Troubleshoot high-availability or load-balanced environment

While using a high-availability or load-balanced environment, one of the servers running advanced
workflow fails, all calls in progress are interrupted and rerouted to another available host. In
addition, new calls go through the new host. This protects users.

If a failure occurs, while running a data feed, check the data logs for any lost information. View the
data feed results log, Archer.ArcherTech.DataFeed.log in the directory set during installation.

Sometimes the Job Framework response time is too fast for the load balancer. To extend that time,
alter the ArcherTech.JobFramework.exe.config or web.config files according to the error listed in
following chart:

Error Encountered Setting Description
Advanced workflow HTTP wpRetryAttemptsOnFailure The number of times to retry
request error, attempt X. The a failed connection to the
operation will be retried in X Workpoint API before
milliseconds. stopping (default is 5).
Advanced workflow HTTP wpRetryDelayMillisec How many milliseconds to
request error. wait between attempts at API
calls to Workpoint (default is
2000).

Troubleshooting Cache
When working with Cache, it is important to understand the following:

File or Process Description

ArcherTech.JobFramework.Cache.exe This service minimizes the number of database calls
that the job engine makes to the SQL server.

Note: While this service has cache in the name, it
is not involved with the caching process. Do not
enable or disable this service as part of your
caching set up process.
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Appendix A: Additional Configuration Options

Time Zones

During the initial installation, you must establish the default time zone for Archer. This time zone
becomes the default time zone for all instances and users unless you override it. You can override
the default time zone in any instance (in the Archer Control Panel) or for any user (in the User
Profile of Archer).

The default time zone is stored in Archer as Coordinated Universal Time (UTC). Archer uses this
time standard for converting time and dates based on the instance or user locale. All time is stored as
UTC and converted based on the time zone of the user.

Each user account has a time zone associated with it. Archer uses this time zone to standardize dates
and times entered by a user. When a date field includes the time component, it uses the time zone to
store the date and time in the database as UTC and displays it to other users based on the time zone
associated with the User Profile of the other user.

All values for date fields entered in Archer reside in the database as UTC. However, the Display
Control type determines how Archer handles time.

e For Date only, Archer truncates the time.

e For Date and Time, Archer converts the time based on the time zone associated with the user
profile.

Example: Date only

The following table describes the example scenario, action, and result.

User 1 is in time zone (UTC-6:00) Central Time (US & Canada).

Scenario
User 2 is in time zone (UTC+5:30) Chennai, Kolkata, Mumbai, New Delhi.
User 1 enters the date 11/14/2017 in record A.
Action
The date is stored in the database as 11/14/2017 00:00:00 UTC.
User 2 accesses record A and sees 11/14/2017 as the date.
Result Because the field is Date only, the time is truncated and is shown to the user as the

date stored without time.

Example 2: Date and time
The following table describes the example scenario, action, and result.
User 1 is in time zone (UTC-6:00) Central Time (US & Canada).
User 2 is in time zone (UTC+5:30) Chennai, Kolkata, Mumbai, New Delhi.

Scenario
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User 1 enters the date 11/14/2017 and the time 10:13 P.M. in record A.

Action The date and time are converted based on the time zone of user 1. As a result the
date and time are stored in the database as 11/15/2017 04:13:00 UTC.

User 2 accesses record A and sees 11/15/2017 9:43:00 A.M.

Result Because the field is Date and Time, the date and time are converted from UTC to
the time zone of user 2.

Data feeds and calculated fields use UTC. Consider a calculated field with the DATEFORMAT
function with Example 2, the date and time is displayed as 8/15/2012 04:13:00 UTC for all users
regardless of their time zone. The date and time are stored in a text field. When the date and time is
stored in a text field, the data is not converted because Archer recognizes the date as text only.

The DATEFORMAT(NOW(),"yyyy-MM-dd hh:mm tt") function displays the current date and time
in UTC in the format you want. If you want to store it in a Date Field with time enabled, convert the
literal to a date time serial value.

DATETIMEVALUE(DATEFORMAT(NOW(),”’yyyy-MM-dd hh:mm tt”)) displays the current date
and time converted from UTC to the current time zone of the user because the data is being
displayed in a Date field with time enabled.

A time zone is required when creating schedules to run processes like data feeds and scheduled
recalculations. If the time zone is not specified, the default time zone for the instance is used. This
time zone is set up in Archer Control Panel during the initial installation. For more information, see
the Archer Control Panel Help.

X.509 Certificates

The installation process requires an X.509 certificate. Archer uses this certificate for authentication
between the Web Application and Archer services.

You can create a new certificate during the initial installation of Archer. The certificate is named
Archer Configuration and saved in the Personal area of the certificate store. Export this certificate
for use in future installations. You must always use the same certificate in subsequent installations.

You can change the certificate later. To change the certificate after installation, rerun the installer,
select only Web Application and Services, and then select the Use a different certificate option.

If you already have an X.509 certificate, determine its location and provide that information when
requested during the installation.

Installation Options

During a new installation, Archer prompts you to either create an X.509 certificate, import an
existing certificate, or select an existing certificate already in the certificate store. It is recommended
to create a new X.509 certificate for all new installations unless you have an existing certificate.
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Create a certificate

Create the Archer Configuration certificate and save it in the Personal store of the certificate store. If
you choose to create a new certificate, the new certificate does not interfere with other certificates in
IIS, such as an SSL certificate. Make a note of this certificate so that you can use it during the
installation. The new X.509 certificate has the following parameters:

Parameter Value

Issuer CN = Archer Configuration
O = Archer

Subject CN = Archer Configuration
O = Archer

Valid to December 31, 2039

Signature algorithm = sha512RSA

Private key RSA (1024-bit)

Select from disk

Designates an existing certificate not yet imported into the certificate store. If you select to import a
certificate, you must select the file in which the certificate is located and provide the password to the
private key.

Select from certificate store

Designates an existing certificate from the certificate store.

Configuration Service Authentication

The Archer Control Panel and Archer Web Services authenticate to the Archer Configuration Service
using the X.509 certificate. During installation, Archer allows you to do the following:

e Use an existing X.509 certificate, for example, one issued and signed by your Root CA. It is
recommended that you use a domain certificate or a certificate signed by an external CA and
generated in accordance to industry best practices.

e Have the installer generate an X.509 certificate for you. In this case, the installer generates a self-
signed certificate.

The X.509 certificate used for authentication to the RSA Archer Configuration service does not
interfere with other certificates used within IIS, such as your SSL certificate.
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Export the X.509 Certificate

Complete this task to export the initial certificate for use in future installations. The same X.509
certificate must be used for all subsequent installations.

Begin at the server where the certificate was created.

1. Click Start > Run > MMC.

Select File > Add/Remove Snap-ins.

From the Available Snap-ins list, select Certificates and click Add.
Select Computer Account and click Next.

Select Local Computer and click Finish.

Click OK.

Expand Certificates > Personal folder. Right-click RSA Archer Configuration and select All
Tasks > Export. The Certificate Export Wizard starts.

A

0

Select Yes, export the private key and click Next.
9. Select Personal Information Exchange - PKCS #12 (PFX) format.
10. Select Export all extended properties and click Next.

11. Designate a password to protect the private key, and select a local directory in which to export
the certificate.

Configuring a Load Balancer for Archer

This section describes the process for installing and configuring Archer in a high-availability,
multiple-server configuration using a load balancer to distribute load based on server availability.
The target audience is Archer administrators installing Archer and anyone responsible for managing
and configuring Archer servers.

A load balancer is a device that acts as a reverse proxy and distributes network or application traffic
across a number of servers. Load balancers increase capacity for concurrent users and reliability of
applications.

Because session state and ViewState information needs to be shared between the Web Servers, a
mechanism must also be provided to ensure this information can be processed by any web farm
server. The server is configured through the Machine Key option of the Archer site, which is added
to the web.config file in the Web Application directory of each Web Server.

Alternatively, the global machine.config file can be modified.
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Requirements for a load-balanced installation
e An Active Directory domain account to configure access shared file server resources.

e A file share that hosts common Archer files and access to the domain account set to Modify
Access.

e All web servers are configured to use the same X.509 certificate.

e All services are configured to use the same account with the installer to configure the correct
permissions.

e All servers containing IIS and Advanced Workflow Services must be able to communicate
through port 8000.

Note: The permissions on the X.509 Certificate used by the web and application servers grant the
Active Directory domain account read access to the private key.

Installation process
1. Plan for installation.
. Install the Archer.
. Update the web.config file on Web Servers.

2
3
4. Configure load balanced URL on software or hardware load balancer.
5. Verify Archer can be accessed via the load balanced URL.

6

. Test the installation.

Task 1: Preparation
Before configuring the Web Servers for load balancing, do the following:

1. Verify that load balancer, application, and database servers are located on the same local area
network.

2. Verity that you have the Platform installation package.

3. Verify that you have administrative access for all applications and Web Servers that will host the
Archer Platform.

4. Create an X.509 Certificate to be used for authenticating to the configuration service from the
Web Application and Archer Services. The certificate may be a new or existing organizational
X.509 Certificate, or you may elect to self-generate it as part of the installation process.

5. Generate a common Machine Key to be used by IIS on all web farm servers.

6. Set up an Active Directory domain account for impersonation purposes, and configure a UNC-
accessible SMB file share accessible by all servers running Archer application code. These
servers are used to host common files such as search indexes, file repository, and company files.
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7. Configure least-privilege permissions on a file system and shared directory structures, which will
host common files and verify that the Active Directory domain account has appropriate access to
the network share.

8. Modify the identity of the application pool used by the Archer web and application services for
the Active Directory domain account configured above.
Task 2: Install Archer

Complete the installation process as described in Chapter 2: Installing Archer.

Task 3: Generate the machineKey

The format of the Machine Key setting appears as follows:

<machineKey

validationKey="some long hexadecimal value"

decryptionKey="another long hexadecimal value"

validation="SHA256"/>

1. Start IIS manager on one of the Web Servers being configured for load balancing.

2. From the Sites node, select the Archer site, and double-click the Machine Key applet.
3. On the Machine Key page, do the following:

a. Set the values of the following parameters. For information on the values see
https://technet.microsoft.com/en-us/library/hh831711(v=ws.11).aspx.

¢ Encryption Method
¢ Decryption Method
b. In the Validation Key and Decryption Key sections, clear any selected options.
c. In the actions panel, select Generate Keys.
4. In the Actions panel, click Apply to save the generated keys to the web.config file.
The generated keys appear in the Validation key and Decryption key sections.
5. For all subsequent Web Servers, do the following:
a. Copy the generated key values from the Validation key and Decryption key sections.
b. At the other Web Servers, repeat steps 1 - 3b to generate the machineKey.

c. Paste the values from the generated machineKey into the respective Validation key and
Decryption key boxes on the Machine Key page.

d. In the Actions panel, click Apply.
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Task 4: Test the load balanced URL

1. Verify whether you can access Archer through the load balanced URL.
Common problems that may occur post-configuration include dashboards not displaying
correctly or file-repository access failing. If either condition occurs, access each Web Server
individually from your browser instead of using the load-balanced URL to identify which
systems may be having issues.

2. Verify the following:

e The IIS application pool is configured to run under the correct Active Directory domain
account credentials.

e The Machine Key setting in the web.config file matches the applicable Validation key and
Decryption key values.

Installing Offline Access

The installation process for Offline Access is separate from the Archer installation. It is
recommended to install Offline Access on a client laptop or computer. To install Offline Access, use
the installation wizard to guide you through the process.

Note: Currently, Offline Access supports the Audit Engagement, Audit Entity, Audit Plan, Audit
Workpaper, IA Engagement and Assessment Results, Internal Audit Department Annual Review,
Plan Entity and Question Library applications.

Preparing for Offline Access Installation

Review the required versions of the following components before installing offline access. For the
supported and qualified software and environments, see Archer Qualified and Supported
Environments on the Archer Community. (https://community.rsa.com/t5/archer-platform-
documentation/rsa-archer-qualified-and-supported-environments/ta-p/568750)

e Microsoft Windows Operating System
* Memory

e Disk Space

e Additional Software

e Microsoft Sync Framework: must be installed on the Services Server. For more information, see
Preparing the Services Servers.

By default, the offline access data is stored on the local computer at C:\Users\
[username]|\AppData\Roaming\RSA Archer\Offline Access\. Isolating the offline access data ensures
that each offline access user has their own environment for working offline. For example, when a
user purges offline access data, only the offline access data of that user is purged.
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Anti-virus and firewall applications may interfere with Offline Access run-time activities. You must
add the Offline Access installation file as a trusted file/process/installer/updater for any anti-virus
and firewall applications that may interfere with the installation.

Before running offline access, start the Distributed Transaction Coordinator service on the laptop
using offline access.

Install Offline Access

The offline access version must always match the Archer version.

A

Important: You must have administrator rights to install offline access. If you are upgrading
offline access, close the Offline Access utility before starting the installation.

. Contact your IT Administrator to obtain the Offline Access installation file.

The IT Administrator downloads the Offline Access installation file from the RSA site and can
provide it to you or auto-deploy the file through a software management system.

Double-click the Offline Access installation file.

On the Offline - InstallShield Wizard page, click Next.

Read the license agreement. Select I accept the terms in the license agreement. Click Next.
Do one of the following:

e To accept the default installation folder, click Next.

e To designate a different installation folder, click Change and specify the path to the folder
where you want to install offline access.

Click Install. This process takes several minutes to complete.
Click Finish to complete the installation.

Add the following Offline Access files as trusted processes for any anti-virus and firewall
applications.

The following table lists the files and their default locations.

File or Process Default Location

Archer.Offline.Tools.Controller.exe C:\Program Files\RSA Archer\Offline Access

Archer.Services.Queuing.exe C:\Program Files\RSA Archer\Offline
Access\services

ArcherTech.JobFramework.Cache.exe C:\Program Files\RSA Archer\Offline
Access\services

ArcherTech.JobFramework.Host.exe C:\Program Files\RSA Archer\Offline
Access\services
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File or Process Default Location

ArcherTech.JobFramework.Job.exe C:\Program Files\RSA Archer\Offline
Access\services

iisexpress.exe C:\Program Files\IIS Express

sqlservr.exe C:\Program Files\Microsoft SQL

Server\110\LocalDB\Binn\sqlservr.exe

SqlLocalDB.exe C:\Program Files\Microsoft SQL
Server\110\Tools\Binn\SqlLocalDB.exe

Application Pool Requirements

An application pool is required for administrating the Archer Web Application. The application pool
defines the set of Web Applications that share one or more worker processes, which are Windows
processes that run Web Applications.

Required values for configuring the application pool

Property Value
Application Pool Name [user defined]
NET CLR version .NET CLR 4.0

Start application pool immediately = Select this checkbox

Log Description

The following table shows the security-relevant logs provided by Archer.
Component Location
Security Events Report = The instance database
Archer Error Logs File system in the configured logging directory

Windows Event Logs Event Viewer
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Security Events Report

The Security Events report contains a list of all of the security-related events that have occurred in
Archer. It is recommended that administrators define and enforce a retention policy for the Archer
Error logs, as well as the Windows Event logs, in accordance with your corporate IT policy and
security best practices. This report includes the following security events:

e Access Role Created

e Access Role Deleted

e Access Role Modified

e Account Status Modified

e Configuration Administrator Added

e Configuration Administrator Deleted

e Content Administrator Added

e Content Administrator Deleted

e Failed User Login

e Full Application Content Delete

¢ Global Report Permission Granted

e Global Report Permission Removed

e LDAP Configuration Delete Started

e LDAP Configuration Delete Completed
e Maximum Login Retries Exceeded

e Offline Access Sync Requested - Download
e Offline Access Sync Requested - Upload
e Password Changed by Administrator

e Password Changed by User

e Reset Password Requested

e Role Assigned to User

e Role Removed from User

e Security Events Started

e Security Events Stopped

e Security Parameter Assignment Modified

e Security Parameter Created
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e Security Parameter Deleted

e Security Parameter Modified

e Sub-Form Configuration Administrator Added
e Sub-Form Configuration Administrator Deleted
e User Account Added

e User Account Deleted

e User Account Modified

e User Added to Group

e User Full Name Modified

e User Login

e User Login Name Modified

e User Logout

e User Removed from Group

Archer Error Logs
You can configure the location of the Archer error log in the Archer Control Panel at both the
installation and the instance level. The default log location for the instance is C:\ArcherFiles\logging.

It is recommended that you configure the setting at the installation level and allow the location for
the instance level to default based on the installation setting.

For more information, see "Logging Settings" and "Verify the Logging Properties" in the Archer
Control Panel Help.

Log Directory Permissions

It is recommended that you restrict the permissions on the log files folder to the same read, write,
and modify permissions of the account that the IIS processes and the Archer-installed services are
running.

For more information, see "Task 5: Grant Permissions to Archer Directories" in Configuring the
Web Server.

Windows Event Logs

The following items are logged in the Windows Event logs by the Archer services and Web
Application:
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e Service Start (Application and System logs)
e Service Stop (Application and System logs)
e NET Runtime Errors

Cloud and Hosting Support

Archer supports hosting in Microsoft Azure® and Amazon Web Services® (AWS) cloud
environments. This section provides information to assess and plan for an installation using cloud
environments.

When using cloud vendors, only using virtual machines to run your Archer environment is
supported.

Use the same process for a cloud or hosted environment as outlined in the Archer Platform Planning
Guide to determine your environment size. Choose a product from your cloud provider that most
closely matches your configuration requirements.

For example, consider the specifications for a small environment given in Archer Platform Planning
Guide. As of this publication, the details in this table are accurate based on current vendor
specifications.

Azure (Standard_

Element Small Environment = AWS (m4.xlarge)
DS3 package)

Processor Four cores Four cores Four cores
Memory 16 GB 16 GB 14 GB
Disk Space 50 GB HDD 100 GB SSD (Using 100 GB HDD

Elastic Block Store)
Note: This table describes hardware requirements only. To understand all requirements for your
configuration, see "Sizing Guidelines" in the Archer Platform Planning Guide.
Other factors to consider when preparing your cloud-based configuration:

e Input/Output per second (IOPS) directly affects your Archer performance. If you find your
performance is slow, consider choosing a vendor product with more IOPS per disk.

e Communication between your on-premises systems and your cloud vendor is key. Contact your
vendor to select a method that works best for your environment.

For more information about the different vendor products offered, review the Azure and
AWS documentation:
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e For Azure, see https://docs.microsoft.com/en-us/azure/.

e For AWS, see https://aws.amazon.com/.

Search Plug-In for Elasticsearch

If Elasticsearch is used as a search provider, then keyword and global search will return results only
if the Archer-provided search plug-in is installed in all nodes of the Elasticsearch cluster. The
provided plug-in can be found in the installed tools directory of your Archer system in the following
location: <BuildName>\support\Tools\join-search-plugin.0.0.1\.

To install the plug-in on an Elasticsearch node, use the following command:
elasticsearch-plugin install "file:///<FILEPATH>"

For example, elasticsearch-plugin install "file:///C:\join-search-plugin-0.0.1.zip"

To remove the plug-in, use the following command:
elasticsearch-plugin remove join-search-plugin

For more information about configuring Elasticsearch, see "Enabling Elasticsearch" in the Archer
Control Panel Online Help.

Geocoding

If your environment uses geocoding, configure geocoding for Archer. Three geocode keys are
included in the Web Configuration file.

The following table describes each geocode key.
Geocode Key Description

numberOfParellelGeocodingThreads The number of parallel threads created to keep
geocoding running. By default, the value is 10.

GeoCodeChunkSize The number added to the payload size for the network
traffic from the Archer Client and the Archer Server.
When the value is high, each requested geocode
payload size is high. When the value is low, each
requested geocode payload size is low.

The number of the geocodes that must be added. By
default, the GeoCodeChunkSize value is 100.

numberOfGeoCodingTrials The number of attempts you allow Archer to geocode
addresses. By default, the value is 3.
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Task 1: Configure the Web Configuration file

1. Open the web.config file from the following folder:

\inetpub\wwwRoot\[IS App Name

I Note: The default name is RSAarcher.
2. Verify the geocode key values.
3. If you updated geocode values, reset IIS.
a. Go to Start > Run.
b. In the Open field, enter the following:
iisreset.exe

c. Press Enter.

Task 2: Configure geocoding proxy in the Archer Control Panel

In the Archer Control Panel, add the port and address of the proxy server that allows traffic from the

following URLs:
e http://dev.virtualearth.net/REST/v1/
e https://dev.virtualearth.net/REST/v1/

For more information about configuring Maps, see "Registering Your Bing Maps Account for
Configuring Trusted IP Addresses for an Instance" in the Archer Control Panel Online Help.

Task 3: Configure geocoding on the Web Server

Verify that the web server has one or both of the following:

¢ [nternet connection

e Geocoding proxy
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Appendix B: Test Environment

Test Environment Configuration Requirements

It is recommended that you use the latest version of the software listed for running Archer in a
single-server configuration. All components except the database run on a dedicated Web Server. It is
recommended to use this configuration only for running a test environment of Archer.

A test environment configuration does not require a high-performance or high-availability solution.
Here are the recommendations for software for the components. For the supported and qualified
software and environments, see Archer Qualified and Supported Environments on the Archer
Community. (https://community.rsa.com/t5/archer-platform-documentation/rsa-archer-qualified-and-
supported-environments/ta-p/568750)

e QOperating System: Microsoft Windows Server (Standard or Datacenter editions)

e Database: Microsoft SQLServer

e Web and Services:
e Microsoft Internet Information Services (included in Microsoft Windows Server)
e Microsoft Office Filter Packs (to enable indexing of MS Office files)

e Microsoft Sync Framework (for offline access)

The following figure illustrates a single-server configuration.

Server File Server Database Server

¢ Web Application e Company files e Instance databases

e Services * File repository * Configuration database
e Services

Installing All Components for a Test Environment

You can install Archer in a single-server configuration. This configuration is only suitable for an
environment that does not require a high-performance or high-availability solution, for example, a
test environment.
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Task 1: Prepare the installer package

1.

Download the Archer installer package from Archer Community.
https://community.rsa.com/t5/archer/ct-p/archer

(Optional) Verify that you have downloaded the installer package correctly by comparing the
checksum values from your downloaded Archer files to the checksum values for your Archer
Platform version displayed on the download page.

Use the Run as Administrator option to extract the installation package on the server to a location
that is accessible to other servers.

Back up the instance and configuration databases created during the server preparation process.
This process ensures that your data is current so that you can recover it if necessary.

Task 2: Run the installer

Run the installer on all web and services servers.

L.

A R

Open the installation folder, and right-click ArcherInstall.exe.

Select Run as Administrator.

Click OK.

Select the appropriate language for the installer to use.

Read the license agreement, and select [ accept the terms in the license agreement.
Read the Diagnostics and System Data License.

Click Next.

Task 3: Install all components

In addition to installing all components, this installer establishes the connectivity to the instance
database that typically resides on a different server.

Begin at the Archer - Installation Options page.

1.

Verify that only desired components are selected.
Note: Make sure to select the same components previously installed before running the
upgrade. If running the installer against a specific component is required, ensure that the other
components installed on the same server are also selected—otherwise, the installer will
uninstall them.
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Clearing the Services component results in all installed services except for the Configuration
Service and Advanced Workflow Service being uninstalled. Clearing the Advanced Workflow
Service results in that service being uninstalled.

e Web Application

e Services

e Instance Database

e Advanced Workflow
2. Click Next.

Task 4: Specify the X.509 certificate

Important: You must use the same X.509 certificate during installations on all types of servers.
For more information, see X.509 Certificates.

Begin at the Archer - Specify Certificate page.
1. In Specify where to obtain the X.509 certificate, do one of the following:
* Select Create a certificate to create a new certificate.
e Select an existing certificate from a disk or a certificate store.
o If selecting from a disk, do the following:
a. Choose Select from disk.
b. In Specify the file to import into the certificate store, clicklzl and select the certificate
file.
c. Click OK.
d. In Type the password for the private key, enter the applicable certificate password.
° If selecting from a certificate store, do the following:
a. Choose Select from certificate store.

b. In Select a certificate from the store, expand the category and select the certificate.

2. Click Next.

Task 5: Set the configuration database options

Complete this task only if prompted during the installation process. If the installer detects the Archer
Configuration service, the Archer - Configuration Database Options page does not display.
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Begin at the Archer - Configuration Databases Options page.

1.
2.

In SQL Server, enter the SQL Server that hosts the Configuration Database.

If you are using a SQL Server account, enter the following, otherwise, go to step 4.
e Login name

e Password

If you are using integrated security, do the following, otherwise, go to step 4.

a. Select User integrated security.

b. In Database, enter the Instance Database.

In Database, enter the Configuration Database.

Click Next.

Task 6: Configure Advanced Workflow HTTPS

Begin at the Archer - Specify HTTPS Binding Certificate page.

I Note: Advanced workflow requires a dedicated certificate.

L.

Enter the port to securely communicate with the Advanced Workflow Service in HTTPS Port.

2. Do one of the following:

Appendix B: Test Environment

Note: The port numbers for Advanced Workflow REST URL and Advanced Workflow
Communication Port cannot be the same when using HTTPS. For example, by default, the
Advanced Workflow REST URL default port is 8443 and the Advanced Workflow
Communication default port is 8000.

e Use HTTPS
° Specify where to obtain the X.509. Do the following:
B [f using current certificate, select Use current certificate.
I Note: This option is unavailable, if this is the first installation for your configuration.
B [f selecting from a certificate store, do the following:
a. Select from certificate store.
b. In Select a certificate from the store, expand the category and select the certificate.

° Specity the HTTPS Port.

Note: If the system detects the specified port number is in use, you must confirm you
wish to replace the certificate bound to the specified port.

e Use HTTP only (Not recommended).
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3. Click Next.

Task 7: Set the REST URL and Communication Port for Advanced Workflow service

Begin at the ArcherAdvanced Workflow Settings page.
1. If using HTTP, click Next.

2. During HTTP, Archer uses default ports and URLs.
3. Ifusing HTTPS, do the following:

a. Change Advanced Workflow REST URL to the same value specified when configuring
Advanced Workflow HTTPS. For example, https://hostName:8000/ where hostName is the
fully qualified domain name of the host where the Advanced Workflow Service is installed.
If there are multiple Advanced Workflow Service hosts, hostName is the FQDN name for the
load balancer and the port number refers to the port for which you have configured the load
balancer.

b. Change the Advanced Workflow Communication Port to a different port than you specified
when configuring Advanced Workflow HTTPS. (The default value is 8000).

Note: If this is a new install, the system populates this field with information from the
certificate and HTTPS port used to configure Advanced Workflow HTTPS.

c. Click Next.

Task 8: Select the Archer language

If you did not check the Instance Database box in Task 6, this task is skipped automatically.
Begin at the Archer Language page.

1. In Select the language for Archer, select the language that you want to use for Archer. By
default, the language is US English. The supported languages are English (US), Chinese
(Simplified), French, German, Italian, Japanese, Portuguese (Brazil), and Spanish (Latin
American).

2. Click Next.
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Task 9: Set the instance database options

Begin at the Archer - Instance Database Options page.

1. In SQL Server, enter the server name.
If the SQL Server is configured for a custom port, enter [servername],[portID].

2. Ifyou are using a SQL Server account, enter the following, otherwise go to step 4.
e Login name
e Password
3. If you are using integrated security, do the following, otherwise go to step 4.
a. Select User integrated security.
b. In Database, enter the instance database.

4. Click Next.

Task 10: Set the default time zone

This time zone for the configuration database applies to all instances unless you override it for a
specific instance in the Archer Control Panel.

Note: If the installer detects a timezone, the web application options page opens and you can
move on to task 11.

Begin at the Archer - Time Zone page.
1. In Time Zone, select the default time zone for Archer.

2. Click Next.

Task 11: Configure the Web Application options

Begin at the Archer - Web Application Options page.
1. In Website, select the destination site for the Archer Web Application.

2. Under Destination directory, verify that destination directory is set to the Web Application
installation:

e Install in the website's default application.

e Install in an IIS application.
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3. Click Next.

4. Click Yes to confirm the destination directory.

Task 12: Enable HTTPS automatically for communication between Web Servers and

web traffic

If prompted, begin at the Archer - Specify HTTPS Binding Certificate page.
1. Do one of the following:
* Use Existing Binding.
e Create New Binding.
° Specify where to obtain the X.509. Do the following:
B [f selecting from a disk, follow these steps:
a. Select from disk.
b. In Specify the file to import into the certificate store, click IZI and select the
certificate file.
c. Click Open.
d. In Type the password for the private key, enter the applicable certificate password.
B [f selecting from a certificate store, do the following:
a. Select from certificate store.
b. In Select a certificate from the store, expand the category and select the certificate.

2. Click Next.

Important: It is recommended to remove any existing HTTP binding from IIS to ensure secure
configuration.

Task 13: Configure the service credentials
Begin at theArcher - Services Credentials page.
1. Select

e Use the Local System account to run all services.

» Use the specified account to run all services and provide Account Credentials.

2. Click Next.

Appendix B: Test Environment 104



Archer Platform Installation and Upgrade Guide

Note: To allow correct Archer Services installation, ensure that Log on as a Service is enabled for
the Window Services Account.

Task 14: Set the services and application file paths

Begin at the Archer - Services and Application Files page.

1. In Services, enter the path where the services are installed.
By default, the path is C:\Program Files\RSA Archer\Services.

2. In Application Files, enter the path where the application files are installed.
By default, the path is C:\Program Files\RSA Archer.

Note: It is recommended that you do not install Web Application or products in the same
virtual directory or Root of Archer. Browsers send Cookies if more than one Web Application
resides in same space; this behavior may lead to passing Archer cookies to any other
application installed in same Root or Virtual Directory.

3. In Program Group, do one of the following, and click Next.
e Create RSA Archer program group for the current user only.
e Create RSA Archer group for all users (Recommended).
e Do not create RSA Archer program group.

4. Click Next.

5. Click Yes to confirm the newly created directories and program group.

Task 15: Set the log file path

Begin at the Archer - Log Location page.

1. In Log Path, enter the folder in which you want to store the log files. All servers in the Archer
environment use this path for logging events. When setting this path, use the same path for all
web and services servers.

2. Click Next.

Task 16: Perform the installation

Begin at the Archer - Perform Install page.

1. Click Next.
The installer starts installing the applicable components. A progress bar opens.
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2. Wait for the installer to complete installing the applicable components.

3. Click Finish.
The ArcherControl Panel opens.
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Appendix C: Qualified and Supported Environments

Use the latest qualified versions of specific software for running Archer in the recommended
configuration. For the supported and qualified software and environments, see Archer Qualified and
Supported Environments on the Archer Community. (https://community.rsa.com/t5/archer-platform-
documentation/rsa-archer-qualified-and-supported-environments/ta-p/568750)
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Appendix D: Checklists and Worksheets

Preparation Checklist

This checklist is for a new installation and is provided for your convenience.

Prepare the Database Servers
See Preparing the Database Server for information on completing each task.
a Task 1: Verify Database Requirements

a Task 2: Choose Authentication Method

Prepare the Web Servers

See Preparing the Web Servers for information on completing each task.
a Task 1: Verifty Web Server Requirements

a Task 2: Configure IIS

a Task 3: Verify Application Pool Requirements

a Task 4: Confirm User Account

Prepare the Services Servers

See Preparing the Services Server for information on completing each task.
a Task 1: Verify Services Server Requirements

a Task 2: Configure Network Share

a Task 3: (Optional) Configure Keyword Indexing
for Attachments

Installation Checklist

You must perform all new installations on the designated servers for the web and services roles. If
you are upgrading Archer from an earlier version, please see Upgrading Archer.
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Run this installation on each web and Services Server. See Installing the Web Application and
Services Components for more details.

Install the Web Application and Services Components
a Task 1: Prepare the installer package

d Task 2: Run the installer on all Web servers and Services
servers

Task 3: Install the Web Application, and services

Task 4: Specify the X.509 certificate

a Task 5: Set the configuration database options (if
prompted)

a Task 6: Configure Advanced Workflow HTTPS

Q Task 7: Set the REST URL and Communication Port for
Advanced Workflow service

a Task 8: Select the language for Archer and content (if
prompted)

a Task 9: Set the instance database

a Task 10: Set the default time zone for the configuration
database

a Task 11: Configure the Web Application options

a Task 12: Enable HTTPS automatically for communication
between Web Servers and web traffic

a Task 13: Configure the service credentials

a Task 14: Set the services and application file paths
a Task 15: Set the path for the installer log file

a Task 16: Perform the installation

a Task 17: In the Archer Control Panel, set the instance
database options

a Task 18: Stop all Archer services except Archer
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Install the Web Application and Services Components

Configuration service

Run this installation on each Services Server. See Installing the Services for more details.

Install the Services Component

a
a

Task 1: Prepare the installer package
Task 2: Run the installer as administrator

Task 3: Install the Services component
Task 4: Specify the X.509 certificate
Task 5: Set the configuration database options

Task 6: Set the default time zone for the configuration
database

Task 7: Configure the service credentials
Task 8: Set the services and application file paths
Task 9: Set the path for the installer log file

Task 10: Perform the installation

Upgrade Installation Checklist

This checklist is for an upgrade installation and is provided for your convenience.

You may perform upgrades on all components at once or on individual components separately. If
you are installing Archer on a fresh system, please see Installing Archer.

Verify the version of Archer that you are using.

Verify your Version of Archer

Q

Task 1: Verify the version of Archer that you are using.

Run the upgrade on all web and Services Servers. Refer to Upgrading All Components for details.

Appendix D: Checklists and Worksheets

110



Archer Platform Installation and Upgrade Guide

Upgrade all Components

a
a

o000 o0 o0

o 0 0 0 0 0 0

Q

Run the upgrade on Services Servers only. Refer to Upgrading the Services Servers for details.

Task 1: Prepare the installer package
Task 2: Stop all Archer Jobs

Task 3: Stop all Archer services except RSA Archer
Configuration service

Task 4: Shut down Archer

Task 5: Run the installer as Administrator

Task 6: Install all components

Task 7: Choose the x.509 certificate from store
Task 8: Configure Advanced Workflow HTTPS

Task 9: Set the REST URL and Communication Port for
Advanced Workflow service

Task 10: Select the language for Archer and content
Task 11: Set the instance database options

Task 12: Configure the Web Application options
Task 13: Set the services and application paths
Task 14: Set the path for the installer log file

Task 15: Perform the installation

Task 16: Start IIS on all Web Servers

Task 17: Verify the instance configuration

Upgrade Services Servers only

a
a

Task 1: Prepare the installer package
Task 2: Stop all Archer Jobs

Task 3: Stop all Archer services except RSA Archer
Configuration service

Task 4: Shut down Archer
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Upgrade Services Servers only

Q

Run the upgrade on all Web Servers only. Refer to Upgrading the Web Servers for details.

Task 5: Run the installer as Administrator
Task 6: Install the services component
Task 7: Choose the x.509 certificate from store

Task 8: Set the configuration services credentials

Task 9: Set the services and application paths
Task 10: Set the path for the installer log file
Task 11: Perform the installation

Task 12: Start IIS on all Web Servers

Task 13: Verify the instance configuration

Upgrade Web Servers only

a
a

o0 o0 o0 o0

U

Task 1: Prepare the installer package
Task 2: Stop all Archer Jobs

Task 3: Stop all Archer services except Archer
Configuration service

Task 4: Shut down Archer

Task 5: Run the installer as Administrator
Task 6: Install the web components

Task 7: Choose the x.509 certificate from store

Task 8: Configure Advanced Workflow HTTPS
Task 9: Set the URL for the Advanced Workflow service

Task 10: Set the REST URL and Communication Port for
the Advanced Workflow service

Task 11: Select the language for Archer and content

Task 12: Configure the Web Application options
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Upgrade Web Servers only

Q

Q

Task 13: Set the services credentials

Task 14: Set the services and application paths
Task 15: Set the path for the installer log file
Task 16: Perform the installation

Task 17: Start IIS on all Web Servers

Task 18: Verify the instance configuration

Activation Checklist

This checklist is for configuring your servers after an installation or upgrade and is provided for your
convenience. If you choose to document your installation, including passwords, secure the document

so you can protect passwords and configuration settings by keeping them confidential.

See Configuring the Web Server for more details. These steps are performed in the Internet

Information Services (IIS) manager, unless otherwise specified.

Configure the Web Server

Q

(N W W

(N W W

Task 1: Specify the account application pool identity.
Task 2: Assign the application pool.
Task 3: Verify application pool for the API.

Task 4: Reconfigure the company files directory as a virtual
directory that is mapped to the network. share

Task 5: Grant permissions to the Archer directories.
Task 6: At the command prompt, reset IIS.
Task 7: Exclude folders from virus scanning.

Task 8: Start the RSA Archer Configuration service.

See Configuring the Services Server for more details.
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Configure the Services Server

a Task 1: Verify the domain user account has access to network
share and company _file directories on the network share.

a Task 2: Verify the X.509 certificate permissions.
Q Task 3: Make the certificate revocation list accessible.

a Task 4: Start the Archer services.

If you use Advanced Workflow, configure it accordingly. Review the following tasks and complete
any that are applicable to your environment. See Configuring Advanced Workflow for more details.

(Optional) Configure Advanced Workflow

a Task 1: Open HTTP on localhost for communication
between the Advanced Workflow service and Archer.

a Task 2: Run the Advanced Workflow service with a non-
admin account.

a Task 3: (Optional) Enable Advanced Workflow in a load
balanced environment.

a Task 4: Ensure Windows host registry key is valid.

Validation Checklist

Use this checklist to ensure that Archer is operational and that you have validated key functionality.
As with any system implementation, testing is vital. While this checklist helps you ensure basic
functionality, it is recommended that you develop a more robust test plan to meet your specific
business practices.

This checklist is for verifying an installation or upgrade. It is provided for your convenience. If you
choose to document your installation, including passwords, secure the document so you can protect
passwords and configuration settings by keeping them confidential.

See Validating Archer as a companion to this checklist.

Archer Testing
See Testing Archer Elements for information.

a Task 1: Open Archer and log in
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Archer Testing

Q

o 0 O O

Task 2: Add and test a new application

Task 3: Test a keyword search

Task 4: Attach a file to a record File Attachment
Task 5: (Optional) Test Advanced Workflow

Task 6: (Optional) If you had custom links in custom
iViews before upgrading, test the links. If any links do
not work, manually relink them.

If the Archer Login page does not open, use the following section to troubleshoot system
components.

Validate Server Settings

See Troubleshooting System Components for information.

Q
Q

Task 1: Validate IIS settings

Task 2: Validate Web Server folder access

If the Archer Login page does not open, use the following section to troubleshoot system
components.

Preparation Worksheet

This worksheet is for a new installation and is provided for your convenience.

Important: If you choose to document your installation, including passwords, secure the
document so you can protect passwords and configuration settings by keeping them confidential.

For more information, see Preparing Archer for Installation as a companion to the worksheet.

Verify your Version of Archer

Q

Verify the version of Archer that you are using. If you are
using Archer 6.2 or earlier, you must first upgrade to
Archer 6.8, then to 6.9. If you are using Archer 6.3 or
later, upgrade to 6.9 and later.
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Details for Database Authentication

Q

Q

Q

Credentials for Instance Database

Credentials for Configuration Database

(Optional) Credentials for Logging Database

Details for Windows Authentication

Q

Credentials for Windows Server Administration

Activation Worksheet

Username:

Password:

Username:

Password:

Username:

Password:

Username:

Password:

This worksheet is for configuring your servers after an installation or upgrade and is provided for
your convenience. If you choose to document your installation, including passwords, secure the
document so you can protect passwords and configuration settings by keeping them confidential.

For more information, see Activation Process as a companion to the worksheet.

Verification Worksheet

Use this worksheet to track details throughout the verification process. Remember to secure your
documents to protect passwords and configuration details.

a
a

Default Instance name.

Instance database credentials

File Repository path. This should be mapped to the
network share.

Search Index path and Queuing server.

Default From Address.
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Instance name:

SQL Server:
Login name:
Password:
Database:

Path:
Search Index path:

Queuing server:

Email From
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Verification Worksheet

a Base and authentication URLSs.

a SysAdmin and Service Account passwords.
Q Instance Serial Number

a Company information.

d Activation method
a Services account application pool credentials
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address:

Base URL:

Authentication

URL:

SysAdmin:
Service Account:

Serial Number:

First name:
Last name:
Company:

Automated
Manual

User name:
Password:
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Appendix E: User Requirements

Client Computers

Review the supported browsers on the Archer Qualified and Supported Environments document on
the Archer Community.
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Appendix F: Uninstalling Archer

This process removes Archer and its associated data. It removes only the directories or files added
by Archer installer. However, it does not remove files added during configuration, such as repository
files, keyword index files, and log files.

If you have installed the components on multiple servers, perform this task on each server.

Important: Do not perform this task if you are upgrading to a later version of Archer. Run the
installer to upgrade the Archer components. Make certain that the Archerlnstall.exe file is in the
same location it was when you installed Archer. The unistall program needs to find this file and
uses its original path. If the file is no longer there, the uninstall will not work.

Uninstall Archer

L.

NS kW

From the Windows Control Panel, do one of the following based on the version of Windows you
are running:

e Click Add or Remove/Programs.

e Click Programs and Features.

Do one of the following based on the version of Windows you are running:

e Select either Archer and click Change/Remove.

e Right-click Archer and click Uninstall/Change.

The Uninstall process starts and the Select Language dialog box opens.

Select the language for the installer. Click OK to continue. The Uninstall Options page opens.
Select the objects that you want to uninstall and click Next. The Perform Unlnstall page opens.
Click Next to continue. The File Progress box opens while the uninstall is performed.

Click Finish. All selected objects are removed.

Delete the SQL databases from the database server.
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Appendix G: Preparing Encryption for Archer
Advanced Workflow

You can optionally set up certificate-based encryption for the Advanced Workflow service. There
are two tasks involved in this, one completed prior to installing Archer, and one completed after the
installation.

Complete the following procedure prior to installation.
1. Copy the certificate to the server that hosts the Advanced Workflow service.
2. Open the Certificate Manager.

a. Click Start.

b. Enter:

certmgr.msc

c. Select Certificate Manager.

3. From the Certificate Manager, right click on Certificate, hover over All Tasks, and click Import.

4. From the Certificate Import Wizard, in File to Import, select the certificate to import, then click
Next

5. In Certificate Store, select Place all certificates in the following store.
6. Click Finish.
Post-installation, complete the following task.
1. Run Windows Services as Administrator.
2. Scroll until the RSA Services appear.
a. Right click Archer Workflow service.
b. Select Stop.
3. Close Windows Services.
4. Make a copy of the following file:
<Installdirectory>\Services\Workpoint\confitemplates\WpServiceHost.exe.config
I Note: The install directory is usually Program Files/RSA Archer.
5. Edit the following file:

<Installdirectory>\Services\Workpoint\conf\templates\WpServiceHost.exe.config
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6. In appsettings, apply comment code to workflowBaseUrlOverride. For example:

<!__ e e o o J“ARCHER SPECIFIC CONFIGURATION o o o o e ol e e o o —_
<appiettings>

<!——add kevy="workflowBaseUrliwverride™ walus="http: localhost: 5000/ workpoint/ resti™ f——=
</applettingss
<!__ e o o o o o o o o END OF ARCHER SPECIFIC CONFIGURATION o o o o o e ol e o o e —_

Lo FEEFFTXXXTFFXXFTEXXEELXEET JARCOHER SPECIFIC CONFIGURATION FH* XX EEXELXEEXLRTFFTFTXTFFFFXTTTT

7. Save WpServiceHost.exe.
8. Run Windows Services as Administrator.
9. Scroll until the RSA Services appear.
a. Right click Archer Workflow service.
b. Select Start.

10. Close Windows Services.
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Appendix H: Importing RSA Certificate into Trusted
Root CA Store

The RSA certificate is not present on every machine’s root store by default. It is required by users
who are simultaneously enforcing the signature check option and utilizing an RSA provided
JavaScript Transporter feed. The certificate must be imported once on each server in an environment.

1.

g S S —y
N N

o % =N kv

Right-click the .JS file and click Properties.

Click the Digital Signatures tab.

On the Signature list, select theRSA signer.

Click Details.

Click View Certificate.

Click Install Certificate.

Select Local Machine and click Next.

Select Place all certificates in the following store and click Browse.
Select Trusted Root Certification Authorities and click OK.

Click Next.

. Click Finish.

Click OK to dismiss the successful import window.

. Launch Certmgr from the Start menu.

Under Certificates — Local Computer, select Trusted Root Certification Authorities.

. Select Certificates and verify there is a new RSA certificate listed.

Export/Import this certificate to all servers in the Archer instance.
Add the certificate's thumbprint in the ACP to trusted list.

For more information, see "Configuring Trusted the IP Addresses" in the Archer Control Panel
Help.
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